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Introduction

NetWitness Investigate provides data analysis capabilities in RSA NetWitness Platform, so that analysts
can analyze packet, log, endpoint, and UEBA data, and identify possible internal or external threats to
security and the IP infrastructure. This guide helps analysts perform investigations of endpoint data
using NetWitness Investigate.

Note: In Version 11.1 and later, the Hosts and Files views provide a view into endpoint data. Earlier
versions offer access to endpoint data using a standalone NetWitness Endpoint server.

For more information, see the NetWitness Endpoint Quick Start Guide, the NetWitness Investigate Quick
Start Guide, and the NetWitness Investigate User Guide.

Endpoint Metadata

Endpoint metadata is generated when hosts are scanned and when there are real-time activities on the
hosts. You can view the following categories of sessions when metadata forwarding is enabled:
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Operating | Scan

System Categories

Tracking Categories

Windows file, service,
dll, process,
task, autorun,
machine, kernel
hook, image
hook, registry
discrepancies,
and suspicious
threads

Linux file, autrorun,
loaded library,
systemd,
process, cron,
initd, and
machine

Process event - Reports any process related activities, such as
openprocess, openosprocess, createprocess,
createremotethread, openbrowserprocess.

File event - Reports any file related activities by an executable,
such as readdocument, writetoexecutable,
renameexecutable, selfdeleteexecutable,

openphysicaldrive.

Registry event - Reports activities that result in registry creation
or modification, such as modifyservicesimagepath,
modifyfirewallpolicy, createservicesimagepath,
createsecuritycenterconfiguration,

modifybadcertificatewarningsetting.
System event - Reports IP change and boot events.
Network event - TCP/UDP and incoming/outgoing.

o Reports outbound and inbound network connections on all
supported Windows platforms.

e Reports IPv4 and IPv6 connections.

Console event (for Windows 8 and later) - User input that is
entered into a console application, such as cmd.exe,
powershell.exe, is captured and reported with the context
console.local.

Commands executed by cmd.exe, powershell.exe as a result
of inter-process communication through anonymous pipes are
captured and reported with the context console. remote.

For example, Get-Item -Path Registry::HKEY LOCAL
MACHINE\SOFTWARE\Microsoft\Windows\

CurrentVersion.

Introduction



NetWitness Endpoint User Guide

Operating | Scan
Tracking Categories

System Categories

Mac file, daemon, e Process event - Reports any process related activities, such as
process, task,
dylib, autorun,
and machine

openprocess, createprocess, openosprocess,
openbrowserprocess, allocateremotememory,
createremotethread.

¢ File event - Reports any file related activities by an executable,
such as writetoexecutable, renameexecutable,
createautorun, deleteexecutable,
selfdeleteexecutable, writetoplist, writetosudoers,

createbrowserextension.
¢ Network event - TCP/UDP and incoming/outgoing.

¢ Reports outbound and inbound network connections on all
supported Mac operating system.

e Reports [Pv4 and IPv6 connections.

For more information on metadata, meta keys, meta values, and meta entities, see the NetWitness
Investigate User Guide.

Risk Score

Analysts can use the risk score to begin an investigation on hosts and files. RSA uses a proprietary
algorithm to calculate the risk scores ranging from 0 to 100. A subset of alerts associated with hosts and
files contribute to the risk score calculation. Analysts can review critical and high alerts associated with a
risk score to identify strong evidence of malicious activity and take required action.

Note: If you have an Insights agent, you can view the risk score for files but not for hosts. To view the
risk score for hosts, upgrade to the Advanced agent. For more information, see the NetWitness
Endpoint Configuration Guide.

The following factors contribute to the risk score:

« Distinct Alerts. Any host or file activities that are suspicious or malicious generate alerts. Only the
distinct alerts are used for risk score calculation.

o Severity of Alerts. Severity of alerts, such as critical, high, and medium.
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DETAI ROC A FILES

[ALERTS SEVERITY

2

CRITICAL

Blackdisted File (28)
28 event(s)

This figure is an example of a host with 2 Critical, 10 High and 12 Medium distinct alerts.

DRIVERS

NT V

11.5.00 06/24/2020 21:30:33

HoT TIME
afewseconds ago

LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

® Events rolled over due to retention policies or manual deletion will not be available.

28 events HOST DETAILS

Show detail: h values only

Windows-security

evenTTYRE  catec
Endpoint  File

GUMENT
2
Administrators
EVENTTYPE

Endpoint

A

EVENTTYPE

20 13:40:54.000 Endpoint ile

Intel(R) 825741 Gigabit Network...

FILENAME LAUNCH ARGUMENT n 00: 6:01:29:06

All the distinct alert shown in the above example can be for the same file or different files. For
example, Configures Image Hijacking alert is triggered for files, such as malware4.exe and

malware’.exe.

RSA

AGENT SCAN STA

Idle

windows

DETAILS AUTORUNS  FILES

ALERTS SEVERITY

2 10 12

CRITICAL HIGH | meoium

Configures Port Redirection (1)
1 event(s)

Creates Shadow Volume For Logical Drive (1)

1 event(s)

Creates Remote Process Using WMI Command-Line Tool (1)

1 event(s)

Enables RDP From Command-Line (1)

1 event(s)

Configures Image Hijacking (12)
12 event(s)

Stops Security Service (1)

1 event(s)

Creates Remote Task (4)

4 event(s)

DRIVERS

T LAST SEEN AGENT VERSION

11500 psuot mime  06/24/2020 21:30:33

afewseconds ago

LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

@ Events rolled over due to retention policies or manual deletion will not be available.

12 events HOST DETAILS  POLICY DETAILS

Type to filter list
T pve

03/01/2019
02:33:08.000" "

pm

CATEGORY ACTION
Process Ev... createProc...

HOSTNAME USER ACCOUNT

OPERATING
.WIN-NMUFVI3DGTN\e...”**TEM e
Show details with values only

Use

FILE NAME INCH ARGUMENT PATH

SOURCE malware7.exe malware7.exe -dll:ioc.dll -testcase:400,401 C:\Users\ecat\Desktop\!
TARGET REG.exe REG C:\Windows\system32\
KLM\SOPI’WARE\chrosoIl\Wwndows Admin true
NT\Currentyersion\mage Fil Execution
(\Dns\se(hc exe" /v Debugger /t REG_SZ /d

windows\system32\cm Administrators

EVENTTIME  EVENT HOSTNAME USER ACCOUNT NG
03/01/2019 {H0 ' Process Ev... createProc... WIN-NMUFVI3DG... WIN-NMUFVI3DGTN\e.. “’“;’"
02:03:08.000"" PO ows
pm

CATEGORY AcTION

1
FILE NAME LAUNCH ARGUMENT PATH

false

SOURCE  malware3.exe malware3.exe -dll:ioc.dll -testcase:400,401 C:\Users\ecat\Desktop\!

TARGET  REG.exe REG.e
A VS ORTWARE Wicrosoft\Wi ndows
NT\CurrentVersion\image File Ex

ecuti
ons\magnify.exe: /v Debugger / REG_52 /d
oy eI e T

C:\Windows\system32\
rk Interfac

Intel(R) PRO/1000 MT Networ...

This figure is an example of files with distinct alerts. Each file can have a multiple distinct alerts. The
files can have a same alert name being triggered by two different hosts as shown below.
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Details  Analysis

ACTIVEON  SIGNATURE  SIZE FILE STATUS  OPERATING SYSTEM
82 2 unsigned 120KB  Neutral mac

ALERTS SEVERITY @ Events rolled over due to retention policies or manual deletion will not be available.

3 events
ey 'MED o " EVENTTIME  EVENTTYPE  CATEGORY ACTION  HOSTNAME USERACCOUNT  OPERATING SYSTEM Type to filter list
i Cl h 02/27/2019 Endpoint  File . mac ¢

JI0:2=50000 Show details with values only
Packed And Network Access (1) am

FILE DETAILS  HOSTS

General
jlleventCy FILENAME LAUNCH ARGUMENT
.MSProc
SOURCE

TARGET 6.631475448608398

Hidden Plist And Autorun (3)
3eventls)

Packed And Autorun (3) EVENTTIME  EVENTTYPE  CATEGORY  ACTION  HOSTNAME USERACCOUNT  OPERATING SYSTEM 120k8

02/27/2019 Endpoint  File L mac
10:45:50.000
El

3 event(s) st macho

Signature
FILE NAME LAUNCH ARGUMENT 2

SOURCE Features unsigned

TARGET

EVENTTIME  EVENTTYPE CATEGORY  ACTION HOSTNAME USER ACCOUNT OPERATING SYSTEM

mac | 5171a462210f540a3005e361c...
2369375ff825f6dSee9bcd296...

02/27/2019 Endpoint File
09:35:46.000
am

56 5d0b9421c46b1d91677791d6...

FILE NAME LAUNCH ARGUMENT

The risk score is reset when you perform any of the following actions:

» Whitelist or blacklist a file after investigation. The risk score of a file is set to 0 on whitelisting and
set to 100 on blacklisting.

 If the alerts or events triggered by the host or files on the host are false positive, you make changes to
the Endpoint Application rules or ESA rules and reset the risk score.

Besides the above factors, the risk score is reset when a file no longer matches Yara rules in the
subsequent scans

Note: When you whitelist a file or reset the risk score, the alerts that contributed to the risk score are
not shown in the Host Details tab.

The host risk score depends on the risk score of all the files on the host. When you change the file status
or reset the file risk score, the host risk score is recalculated. For example, the score for all the hosts on
which a blacklisted file is present is recalculated and becomes 100. If the host is not found to be infected,
you can reset the host risk score. This deletes the alerts contributed to the risk score and does not impact
the global file score. For more information on changing the file status, see Changing File Status or
Remediate.

Note: For the risk score calculation, the ESA Correlation server must be configured with an Endpoint
Concentrator. The application rules are automatically deployed on installation. For an upgrade, you
must deploy the application rules from RSA Live. For more information, see the NetWitness Endpoint
Configuration Guide.

Note: For the accurate risk score calculation, the default multi-valued meta keys are required on the
ESA Correlation service. For more information, see "Configure Meta Keys as Arrays in ESA
Correlation Rule Values" section in the ESA Configuration Guide.

Severity of Alerts

The following table depicts the risk score range based on the associated alert severity:
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Risk Score

Severity

Range
Critical 100
High Orange 70-99
Medium Yellow 31-69

Low 0-30

The following is an example of alerts contributing to the risk score:

ALERTS SEVERITY c
2 events

3 1 6 2 0 3 9 EVENT TIME EVENTTYPE CATEGORY ACTION HOSTMAME  USER

01/02/2019 Log ACCOUNT
06:23:42.000
am

CRITICAL HIGH ' MEDIUM ALL

Enables Cleartext Credential Storage (2)

2 event(s)

FILE NAME LAUNCH ARGUMENT PATH

SOURCE dtf2.exe dif2.exe dilicc.dll C{LUSﬁ_rs
Exports Sensitive Registry Hive (4) S

4 event(s) TARGET REG.exe REG.exe ADD C\Wind:

HELM\System\CurrentControlSe
tlControl\SecurityProviders\WDi
Enables Login Bypass (12) ESRtEg %ﬁb%B}S%F:,EDEN"HL

12 event(s)

EVENT TIME EVENTTYPE CATEGORY  ACTION HOSTNAME  USER
01/02/2019  Log Process ... createpr... b, Pl
06:23:42.000

am

FILE NAME LAUNCH ARGUMENT PATH

SOURCE dtf2.exe dif2.exe -dil:ioc.dll C:\Users
el\archiv

In the above example, there are three distinct critical alerts. For each alert type, associated events are
displayed. You can see that the "Enables Cleartext Credential Storage" alert was triggered twice. The
details of the two events are displayed with the metadata information. For more information on severity
alerts and metadata information, see Analyze Hosts Using the Risk Score and Analyze Files Using the
Risk Score.

Global and Local Risk Score
Analysts can get better context on file activities on hosts using the global risk score and the local risk
score of a file.

Global Risk Score - The global risk score is an aggregate of all suspicious and malicious activities
performed by the file across all hosts. This score indicates the potential threat posed by the file across the
NetWitness Platform.

Local Risk Score - The local risk score is calculated on suspicious or malicious activities performed by
the file on a specific host. The local risk score is used for the host risk score calculation.

For more information on the global and local risk score, see Investigating Files and Investigating Hosts.
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Automated Incident Creation Based on Risk Score

By default, a threshold is set for the risk score to control the generation of incidents and alerts in
NetWitness Respond. For more information on configuring the threshold limit, see the NetWitness
Respond Configuration Guide.

File Reputation

The File Reputation service available on RSA Live checks the reputation of every file hash against an
extensive database of known file hashes updated in real-time. The file reputation is displayed on the
Investigate and Respond views.

The reputations for a file hash are:

Malicious File hash is labeled as malicious.

Suspicious File hash is suspected to be malicious.

Unknown File hash is not known.

Known File hash information is known to the file reputation service and does not have any

previous bad record.
Known Good File hash information is known good, such as files signed by Microsoft or RSA.
Invalid File hash format is invalid.

The suspicious or malicious files are available for further analysis in the Investigate > Navigate view
and Investigate > Events view. For more information on the file reputation service, see the Live Services
Management Guide.

Note: The File Reputation service supports maximum of 10 million files for a reputation of file hash.

File Status

To help analysts triage and focus on their investigation, NetWitness Platform provides capabilities to
manage suspect and legitimate files. For example, you can whitelist files that are legitimate (such as
security products), or blacklist files based on known threats and investigation.

A file can be classified as follows:

o Blacklist: File that is marked suspicious, such as when ransomware is found by scan.

Graylist: File that is marked for a later review.
o Whitelist: File that is legitimate and is not to be considered for risk scoring.

o Neutral: Default status.

For more information, see Changing File Status or Remediate.
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Remediation

If a file is malicious or infected, you can block the file to prevent future execution on any host.
Remediation helps to:

» Stop or reduce the spread of identified malware, such as viruses, trojans, rootkits, worms, spyware,
and adware.

 Identify attempted breach points to aid in deeper analysis; all events are time-stamped allowing
analysts to trace backward to identify the entry point.

* Remove unwanted software, such as adware, which can potentially mask real malware.

» Stop all actions possible by the loader.

You can block files with the following file extension: EXE, COM, SYS, DLL, SCR, OCX, BAT, PS1,
VBS, VBE, and VB. For more information, see Changing File Status or Remediate.

Network Isolation

If you suspect that a host is potentially compromised with the threat still being active, you can isolate the
host from the network and safely investigate possible threats within the host. By isolating the host, you
can control the spread of an attack and analyze the malware behavior. When a host is isolated, only
connection to the following IP addresses are allowed:

e Endpoint Server, Relay Server, DNS, DHCP, Gateways, 0.0.0.0, and 255.255.255.255.

* Other [P addresses that you include in the exclusion list.

In the isolated state, all events are reported to the Endpoint Server retaining full visibility into activities
on the host. You can continue investigation by requesting scans, downloading MFT, files, and so on. The
following metadata is added to the network events:

e network.isolated - indicates that the host is isolated.

¢ network.connectallowed - indicates that the network connection is allowed as the IP address is
included in the exclusion list.

¢ network.connectblocked - indicates that the network connection is blocked.

Note: If the agent is enabled for log or file collection, make sure that you add the Log Decoder IP
addresses in the exclusion list while you isolate the host.

For more information, see Isolating Hosts from Network.
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Focusing on Endpoint Analysis

This guide provides the information needed to conduct an investigation that is focused on endpoint data
from configured hosts. Analysts who conduct analysis using Investigate need to have the appropriate
system roles and permissions set up for their user accounts. An administrator must configure roles and
permissions as described in Roles and Permissions for Endpoint Analysts. For more information on roles
and permissions, see the System Security and User Management Guide.

To hunt for information on hosts that have the agent running, begin the investigation in the Hosts view
(Hosts). For every host, you can see processes, drivers, DLLs, files (executables), services, anomalies,
and autoruns that are running, and information related to logged-in users. (See Investigating Hosts.)

You can begin the investigation on files in your deployment in the Files view (Files). (See Investigating
Files.)

Note: To access the Hosts and Files views, you must have the endpoint-server.filter.manage
permission.

Analysts use the Hosts and Files views to investigate or perform analysis on hosts or files using
attributes such as IP address, host name, Mac address, risk score, and so on. This figure shows the high-
level capabilities of an endpoint investigation. The top box are all the possible starting points, and the
lower box shows the tasks that you can accomplish from different starting points.

14 Focusing on Endpoint Analysis
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Begin or Continue an Investigation in the Investigate View or Pivot from the Respond View

Browse Event
Metadata

(Navigate View)

Analyze Suspicious
Files
(Files View)

Analyze Raw Events
and Metadata
(Events Analysis

View)

Identify High Risk

User

(Users View)

Analyze Files and

Processes on Hosts

(Hosts View)

Triage an Incident

(Pivot from Respond

View)

Acton a Network, Log, or Endpoint Event, or on a User Behavior

Reconstruct an Event

Investigate Process

Analyze Events

Export Hosts
Attributes and Global
Files

Remediate

Create an Incident in
Respond

Perform Internal
Lookups

Analyze Downloaded
Files

Analyze Downloaded
MFT

Isolate Host from
Network

Analyze Risk Score
for Files and Hosts

Analyze Risky Users

Review Anomalies

Download Process
Dump or System
Dump

Analyze Hosts/Files
with File Acitivity

Perform External
Lookups

Analyze Certificates

Change File Status or
Remediate

Focusing on Endpoint Analysis
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Investigating Files

Note: The information in this topic applies to RSA NetWitness Platform Version 11.3 and later.

The Files view provides a holistic view of all files in your deployment. You can apply various filters,
sort, and categorize files into different status to reduce the number of files for analysis and identify
suspicious or malicious files.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
== |Navigate or Event
Analysis View)

Whitelist Files/ ;
Certificates Signed by GRS Download Files for
Known Good Identlfy‘Flle-s for Analyze Files —= Deeper Analysis mm.a Change File Status Remediate
Investigation
Vendors

Perform External

—-

Lookups

o Whitelist all files signed by RSA, Microsoft, and any other known good vendors. Use the filters to list
the files and change the status of all these files to whitelist. For more information, see Filter Files and
Changing File Status or Remediate.

Note: Some Microsoft signed files are restricted from whitelisting as there is a potential risk of
them being used for malicious purposes. To view the list, see Files Restricted from Whitelisting.

* Change the status of certificate and the associated files automatically. For more information, see
Analyze Certificates.

« Filter to exclude whitelisted, files with valid signature, known good files based on reputation status.
For more information, see Filter Files.

* Lookup Google or VirusTotal with the filename or hash to get more information about a suspected
file. For more information, see Launch an External Lookup for a File.

e Analyze the files using one or more of these indicators:

a. Risk score - Displays the risk score for a file. Analysts can view the associated alerts and events
for further investigation. For more information, see Analyze Files Using the Risk Score.

b. On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts
with a high risk score, it may require further investigation. You can also sort or filter using On
Hosts column to narrow down the search during investigation. For more information, see Analyze
Hosts with File Activity.
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c. File status - To manage suspected and legitimate files, analysts can use the file status to manage.
For more information on the various file status, see Changing File Status or Remediate.

d. Reputation status - Indicates the reputation of a file hash for analyst to narrow-down the files to
investigate. For more information, see File Reputation.

e. Signature - A valid signature on a file signed by a trusted vendor, such as Microsoft and Apple
indicates that the file is not a risk. If a file is unsigned, it may be malicious, and needs
investigation.

f. File name - Many trojans write random file names when dropping their payloads to prevent an
easy search across the hosts in the network based on the filename. For example, if a file is named
svchOst.exe, scvhost.exe, Or svchosts.exe, it indicates that the legitimate Windows file
named svchost.exe is being mimicked.

» Investigate a particular file name or hash by pivoting to Navigate or Events view to view context, file
activity on different hosts, and any file transfers across the network through packet data. For more
information, see Analyzing Events.

» Investigate files using a rule-based detection technique. YARA helps to identify threats effectively
using easy-to-create malware descriptions called YARA rules. For more information, see Analyze
Files Using YARA.

* Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

* Change the status of the file (blacklist or graylist), and block an infected or malicious file. For more
information, see Changing File Status or Remediate.

View Files

You can view all files present on a specific Endpoint server or consolidated list of all files on multiple
Endpoint servers using the Endpoint Broker for analysis. To view files:

1. Go to Files.

2. Select one of the following:

Investigating Files 17
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RSA vestigate  Respon dashboards  Reports

Y Filters & endpointloghy... View Certificates @ Change File Status [ AnalyzeEvents | v £ More Actions v

endpointbroker - Endpoint

SAVED FILTERS SEENTIME  ON HOSTS REPUTATION SIZE SIGNATURE PE.RESOURCE... FILE STATUS

\
| endpointioghybrid1 - Endpoint Server
Select i

endpointloghybrid2 - Endpoint Server /202017:0... 2 Known Good 9.5MB  microsoftsignedyalid Microsoft Cor... ~Neutral

PITERATE 06/11/202017:0... 2 Known Good 1439.. microsoftsignedyalid Microsoft Cor... Neutral

Equals e.g. Fi ed 06/11/202017:0... 2 Known Good 3627... microsoftsignedvalid Microsoft Cor... Neutral
06/11/202017:0... Known Good 6590... microsoftsignedyalid Microsoft Cor... Neutral
06/11/2020 17:0... Known Good 567KB  microsoftsignedyalid Microsoft Cor... Neutral

06/11/202017:0... Known Good 802.6... microsoftsignedyalid MicrosoftCor... Neutral

O Whitelist . N -
06/11/2020170... Known Good 135KB  microsoftsignedyal.. Microsoft Cor... Neutral
REMEDIATION 06/11/202017:0... Known Good 7475... microsoftsignedyval... Microsoft Cor... Neutral

O Blocked
06/11/2020 17:0... Known 815KB signedyvalid VMware, Inc. Neutral

06/11/202017: Known 59.5KB  unsigned - Neutral

06/11/202017:0... Known 1113..  signedyalid Microsoft Cor... ~Neutral

O Unknown

O Known 06/11/202017:0... Known 0...  unsigned VMware,Inc.  Neutral

O Known Good

5 10 o 06/11/2020 17:0... Known Good microsoftsignedyal.. Microsoft Cor... Neutral
Invalid

* Endpoint Broker Server to view all files across all Endpoint servers.

o Endpoint Server to view files on a specific Endpoint server.

3. Select the file that you want to analyze.

4. Click a row to view the following details:

RSA

VFilters & endpointioghy. View Certificates “# Change File Status  Analyze Events | § More |3

FILE DETAILS
FILE NAME RISKSCORE  + FIRST SEEN TIME ON HOSTS REPUTATION SIGNATURE PERESOURCES.C_  FILE STATUS

100 11/08/2019 10:510... - microsoft signedvalidca.  Microsoft Corpor.
100 11/08/201910:493 - microsoft signedvalid.ca . Micrasoft Corpor.
100 11/06/201902422. - ivalidca . Microsoft Corpor...
100 11/06/201902415... Z i Microsoft Corpor...

1/17/201910.245.

11/11/201906:59:4...

11/10/201909:51-1.

11/06/201902:42:4...
microsoft signed,valid catalog
03/19/201903:59:28.400am

11/06/201902:41:5.

11/06/201902:41:5...
2e9c12e54763822eec42474983..

11/08/201910:52-1. . ficrosoft Wi
1113201912314

* File Details displays the file information. For more information, see Launch an External Lookup
for a File.

¢ Risk Details displays the distinct alerts associated with the risk score. For more information, see
Analyze Files Using the Risk Score.

¢ Hosts displays the number of hosts on which file activities are present. For more information, see
Analyze Hosts with File Activity.

Filter Files

You can narrow down the investigation by filtering files using file name, on hosts, file status, risk score,
remediation, reputation status, operating system, size, entropy, format, signature, company name,
checksum (MD5 and SHA256), downloaded status, and YARA rules.
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Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. The following fields are indexed in the database - Filename, MD5, SHA256,
Operating System, First Seen Time, Format, File Status, On Host, and Reputation Status.

RSA

¥ Filters x Sendpointloghy._ v || ViewCertificates | | [ 4 ChangeFilestatus || & AnalyzeEvents |~ | | § More v |

[0 FILE NAME RISK SCORE + FIRST SEEN TIME ON HOSTS REPUTATION
O 100 1108/201910510.. 1 -
O 1108201910493 1 -
11/06/201902422 -
11/06/201902:41:5_

11/17/2019 10:24:5_

11/11/2019 06:59:4_.

11/10/201909-51-1

11/06/2019 02424

11/06/201902:41°5_

11/06/201902415...

11/08/201910:52-1

11/11/201912:31:4..

11/11/201912:31:4..

11/08/2019 10:54-1

11/08/2019 10:54-1..

11/08/201910:52-1

1108/201910:52-1

O
O
0
O
O
O
O
O
O
O
O
O
O
O

11/08/201910:52-1

Select the parameters in the Filters tab. Click Save to save the search and provide a name (up to 250
alphanumeric characters). The filter is added to the Saved Filters list. To delete a filter, hover over the

name and click .

Note: Special characters are not allowed in the filter name except underscore () and hyphen (-)
while saving the filter.

For example, to filter the files based on file reputation, select the reputation status in the Filter panel.

Note: For the file size, 1 KB is calculated as 1024 bytes. For example, if the actual size of the file is
8421 bytes, the UI will display it as 8.2 KB instead of 8.22 KB. It is recommended to search using the
bytes format when using the Equals operator.

Add and Sort Columns in the Table

By default, the Files view displays a few columns, and files are sorted based on the risk score. To add or
remove columns:
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1. Go to Files.

2. Select the columns by clicking £ in the right-hand corner.

File Status
Remediation

Reputation

Downloaded

3. Scroll down or enter the keyword to search and select the required columns.

4. To sort the column in ascending or descending order, click the arrow on the column header.

Analyze Files Using the Risk Score

To analyze files using the risk score:
1. Go to Files.
The Files view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the files.

3. Select the file and do any of the following.
o Click a row to view the risk associated with the file in the Risk Details panel.
o Click the hostname to investigate the host.
The Details tab is displayed.

4. In the Alert Severity panel, click the alert severity, such as Critical, High, Medium, or All.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

20 Investigating Files



NetWitness Endpoint User Guide

Note: Only the latest 1000 events are displayed.

6. To view all the metadata associated with a specific event, click the event header. The information
such as source path, target path, filename, and others is displayed.

1

cRITICAL

Enables Login Bypass (6)
()

6 events

03/01/2019 Endpoint
02:34:08.000 pm

SOURCE

PATH
CUsers\ecat\Desktop\

FILE SHAZS6
Oedasbazaddcacs0sceocebashcasifo29dedbe
0992a1€b31130b794134c55dl

FILENAME

malware10.exe

LAUNCH ARGUMENT

malware10.exe -dll:ioc.dll testcase:400,401

DEVICE

Process Event createProcess

@ Events rolled over due to retention policies or manual deletion will not be available.

TARGET

C:Windows\system32\

FILE SHA256
19316d4266d0b77609b2a05d5903d8cbcsf0ea
1520e9c2a7e6d5960b6faddcaf

FILENAME
REG.exe

LAUNCH ARGUMENT
REG.exe ADD
“HKLM\SOFTWAREWMicrosoft\Windows
MCurrentversion\image Fi
Options\displayswitch.exe" /v Debugger /t

windows Oeda8ba34ddc46909c66cebasbc2311029dedbc0992a1 eb31130b794134c55db.

DOMAIN/HOST
WIN-NMUFVI3DGTN

size
a1

DATA
FiLeNAME
malware10.exe

a1
HasH

Oedagba34ddc46909c66cebasbc2311029d
edbc0992a1eb31130b794134c55db

EVENT SOURCE
10.40.14.52:50005

USER SRC
ALIAS IP
EVENT SOURCE ID

118794
USER

REG_SZ/d "C:windows\system32\cmd.exe” /f

Evice AGENT ID
93B4DD24-9103-9792-FIB5-FEG141338C91
DEVICE TYPE

HasH :
nwendpoint

19316042660077645b2205d5903d8cbcsi0ea
af

Oedasbazaddcacs0nceocebashcasifo2adedbe 193000C287e6a0E0DEIAde

0992a1eb31130b794134c55dl

RELATED LINKS

Endpoint  ProcessEvent  createProcess  WINAMUFV3DGIN  WINNMUFVEDGTNcat  windows OedaBba34ddca6909c6eebasbc231f029dedbc092a1eb31130b794134c55db

7. Hover over one of the meta values for IP, Hostname, Mac, File name, File hash, User, and Domain to
view additional information about the specific metadata. A hover box displays a list of the data
sources that have context data available for meta value. These are the possible data sources:
NetWitness Endpoint, Incidents, Alerts, Hosts, Files, Feeds, and Live Connect.

CONTEXT HIGHLIGHTS ACTIONS

0 0
INCIDENTS ALERTS

= Add/Remove from List

Q, Pivot to Investigate > Navigate

OPERATING SYSTEM
windows

USER ACCOUNT
WIN-NMUFRVI3DGTN\ecat

ALERTS SEVERITY

1 3 5

T 3 [P

@ Events rolled over due to retention policies or manual deletion will not be available.
6 events

EVENT TIME EVENTTYPE CATEGORY ACTION HOSTNAME USER ACCOUNT OPERATIN
03/01/2019 Endpoint Process Event createProcess windows

02:34:08.000 pm

HASH
Oedagba34ddca6909)

Enables Login Byp:

SOURCE TARGET DOMAIN/HOST
PATH PATH

C:\Users\ecat\DesktopV C:\windows\system32\

6 event(s)

SIZE
FILE SHA256 a
19316d4266d0b776d9b2a05d5303d8cbcBf0ea
1520e9c2a7e6d5960b6fasdcal DATA
FILENAME
malware10.exe

FILE SHA256
Oeda8ba34ddcd6909c66ceba! 5h(231 fo29dedbc
0992a1eb31130b794134c55db

FILENAWE FILENAME

malware10.exe REG.exe
SIZE

LAUNCH ARGUMENT M

REG.exe ADD

"HKLM\SOFTWAREMicrosoft\Windows HasH

DEVICE NT\Currentversion\image Fl\e Execution Dedasba:md\:Ic46909c66[eb55hc231f029d
Ol I TR WIDE IR eI edbc0992a1eb311306794134c55db

. 57 d "Cwindows\system32cmd exe” /f

USER DEVICE AGENTID
USERNAME 93B4DD24-9103-9792-F985-FE6141338C91

LAUNCH ARGUMENT
malware10.exe -dil:ioc.dll -testcase:400,401

DEVICE TYPE

HASH -
nwendpoint

19316d4266d0b776d9b2a05d5903d8cbcsf0ea
1520e9c2a7e6d5960b6faddcaf

HASH

OedaBba34ddc46909c66ceba: 5hc23 1f029dedbc
0992a1eb31130b794134c55dl

RELATED LINKS
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o To reconstruct an event in a readable form that matches the original, click the Investigate
Original Event link highlighted in blue. For more information on event reconstruction, see the
NetWitness Investigate User Guide.

o For details about the elements associated with an event, click the Investigate Destination Domain
link highlighted in blue. For more information on Contextual Information for an Event, see the
NetWitness Investigate User Guide.

Note: Investigate Destination Domain link is not displayed if there is no domain.dst event.

o To view a list of processes captured on the hosts and investigate a particular process, click the
Analyze Process link highlighted in blue. For more information on process analysis, see
Investigating a Process.

Note: Analyze Process link is not displayed if there is no createprocess event.

Analyze Hosts with File Activity

To view the list of hosts on which a file exist, do the following:

Note: By default, the system detects the best data source for the On Hosts aggregation. To change the
data source, in the Explore view, modify the investigate service ID under endpoint/investigate.

1. In the Files tab, click the row for the file you want to analyze.

2. In the right panel, click the Hosts tab. The list of hosts along with the risk score are displayed.

RSA e Respond sers  Hosts  Files  Dash

< Filters ‘ S endpointloghy... ~ || View Certificates % ChangeFile Status || 7 Analyze Events vH $ MoreActions v/
T

intl
RISK SCOR T SEEN TIME N HOSTS

06/11/202017:05:... 2

06/11/202017:05:...

06/11/202017:05:...

06/11/202017:05:...

06/11/2020 17:05;

06/11/202017:05:...

3. Click the host name to open the host details.

A . . : . .
4. Click to analyze events on the host in the Events view. For more information, see Analyzing
Events.

Analyze Files Using YARA

YARA helps analysts with rule-based detection capabilities in identifying and classifying malware. You
can easily create malware descriptions using YARA rules. Administrators must enable and configure
YARA on the Endpoint server. To learn more about enabling and configuring YARA, refer to

RSA NetWitness Endpoint Configuration Guide.

Files must be downloaded to the Endpoint server and YARA scans the downloaded files automatically.
The scan results are displayed under YARA STATUS on the Files tab.

To analyze the scanned files,
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1. Go to Files.
2. Select the Endpoint server from the server drop-down , to view files.
3. Select a file that is downloaded to the Endpoint server and do any of the following:
¢ Click a row to view the YARA scan details associated with the file in the File Details panel.

¢ [f any file matches one or more YARA rules, the File Details panel displays the matching rule
names besides scan time.

* YARA STATUS field displays the status of the YARA scan. Following are the available statuses
and their definitions

* Matched - The file matches with one or more YARA rules
* Not Matched - The file does not match with any of the YARA rules

* Not Yet Scanned - There is no scan performed for this file. Files will be scanned automatically
once they have been downloaded. After the scan YARA status will be updated to either
Matched or Not Matched

Note: When a file matches with a YARA rule, high severity alerts are triggered and, the file's
risk score is updated. In the subsequent scans, If the same file doesn't match with a YARA rule,
the risk score will be reset.

Note: If a downloaded file has an error, it will not be scanned by YARA and, the
Downloaded column will display the file download status as Error.

osts Files Dashboard Reports

Filters S endpointloghy... v View Certificates % Change File Status (£ Analyze Events 2 More Actions m NWEAgent.exe

. FILE DETAILS
FILE NAME RISKSCORE T FIRSTSEENTIME  ONHOSTS REPUTATION size DOWNLOADED YARA STATUS SIGNATURE ]

02/23/202105:35... - 405KB - - microsoft.signedyalid...
02/23/202105:35... - 502KB Not Matched microsoft,signed,valid Show details with values only

02/23/202105:35...

Time  02/23/202110:27:00.206 am
02/23/202105:35... - - - microsoft,signed,valid

02/23/202105:35... = - = microsoft.signed,valid

NWEAgentexe 02/23/202105:35... Matched signedyalid

02/23/202105:35... - - e et veds] FileName ~NWEAgentexe
6.4298143942554615
38MB
02/23/202105:37... - - microsoft signedyalid...

pe
02/23/202105:37... 3... - - microsoft.signed,valid

02/23/202105:45... - - - microsoftsignedyalid...
signedyalid
02/23/202105:53... - - - microsoft.sign

01/22/202111:58:44.000pm
02/23/202106:58...
1t 004fa928fd12dfaf7f49d95fe581305¢1d4...

02/23/202106:58... 2 - - - microsoft,signed,valid
161 RSASecurity LLC

02/23/202107:39... - - - microsoft signedyalid...

o

[m]

[m]

[m]

[m]

[m]

=4

o

o O} 02/23/202105:35... 8. Matched microsoft.signed,valid
= -
o

[m]

o

[m]

[m]

[m]

[m]

02/23/202109:22... = - microsoft signedyalid...

4. On the Filters pane, scroll to the YARA RULES section. This section provides options to filter the
files based on YARA scan status:

¢ Select Matched to view the files that match YARA rules.

* You can also view the files that do not match YARA rules or not yet scanned against YARA
rules, by selecting Not Matched or Not Yet Scanned from the YARA RULES section.
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RSA vestigate  Respond  Users fosts ~ Files  Dashboard s & B 3 admin

Y Filters 8 endpointloghy... V ‘ View Certificates i)

O Unknown O rFnename RISKSCORE T FIRST SEEN TIME ON HOSTS REPUTATION SIZE DOWNLOADED YARA STATUS SIGNATURE

m} 02/23/202105:35... 3 - 38MB v Matched signedyalid

m} ( 02/23/202105:35... 1 - 87MB v Matched microsoft,signedvalid

Equals

FILE HASH

Equals Enter Value

O Dov
O Error
O Not Downloaded

YARA RULES
Matched

O Not Matched

O Not Yet Scanned

SEEs Showing 2 out of 2 files | O selected

For more information on investigating with YARA, see NetWitness Investigate User Guide.

Analyze Files Using OPSWAT

OPSWAT (MetaDefender Core) provides advanced malware detection capabilities by scanning files with
multiple anti-malware engines simultaneously. Administrators need to enable and configure OPSWAT
on the Endpoint server. To learn more about enabling and configuring OPSWAT, see NetWitness
Endpoint Configuration Guide.

All downloaded files (executable) will automatically be sent to OPSWAT server for scanning once
OPSWAT is enabled and configured on the endpoint servers.

RSA Inv Users osts } -‘ s 8} % @ admin
< Filters S endpointloghy... v View Certificates “ Change File Status  Analyze Events Ni hitel rg Qgﬁ[ﬂ i
staller.ex

O e name RISKSCORE  ONMOSTS ¢ siZE DOWNLOADED  FIRST SEEN TIME OPSWATSTATUS | YARA STATUS FILE DETAILS

B Ninite Chrome FileZilla Installere... (:0:) 2 4153KB v 05/10/202108:18:03 am =
] (o) 16.7KB 05/10/202110:47:29am  NoThreat Detected | — e

Show details with values only
4413KB 05/10/2021 10:30:10am & - T
24.0K8 05/10/2021 10:08:00 am )5/10/2021 11:50:05.542 am

6384KB 05/10/202110:0521am | /\ : ™

Infected (eset)
1367KB 05/10/202110:05:21am | NoThreat Detected Eicar testfile
Infected (bitdefender)
EICAR Test_File
3490KB 05/10/202110:05:21 am (e (7]

Trojan (000139291)
56MB - 05/10/202110:05:21am | — Infected (ctamav)

EICAR Test_File

87.3KB 05/10/202110:05:21 am

2.6MB 05/10/202110:05:21am | NoThreat Detected

3637KB - 05/10/202110:0521am | —

3520KB 05/10/2021 10:05:21 am Fi linite Chrome FileZilla Installer.exe
8820KB 05/10/202110:05:21am | NoThreat Detected

5575KB 05/10/202110:05:21 am

37.9KB 05/10/202110:05:21am | NoThreat Detected

m]
m]
m]
m]
m]
m]
m]
m]
m]
m]
m]
m]
m]
]

45.9KB v 05/10/202110:05:21am | NoThreat Detected Signature
Showing 100 out of 130files | 1 selected
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Scan files with OPSWAT

Downloaded files are automatically sent to the OPSWAT server for scanning. However, you can also
initiate the scan manually using options under theMore Actions menu. Executable files with the
following file extensions, pe, script, macro, and elf are supported by this feature. The maximum file size
limit is set to 10MB by default. You can increase or decrease it if required.

Automatic scan:

The endpoint server will automatically send all (executable) downloaded files to the OPSWAT server.
The scan results will be displayed under theOPSWAT STATUS column on theFiles tab.

Manual Scan:

You can also manually initiate an OPSWAT scan using the options under theMore Actions menu on the
Files tab.

The More Actions menu provides the following options:

Manual Scan - Scan selected files
1. Select the files that need to be sent to the OPSWAT server for scanning.

2. Select More Actions > Scan with OPSWAT.

Y Filters # More Actions \/
Google Lookup

VirusTotal Lookup

Save a Local Copy

N
Scan with OPSWAT ‘

N
Reset Risk Score
No Threat Detected Not Matc...

Not Matc...
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3. Click Scan on the confirmation pop-up.

Scan with OPSWAT

Selected files that are downloaded to the server will be scanned.

e | BB

Manual Scan - Scan all files
1. Select More Actions > Scan All with OPSWAT.

RSA vestigat Respond er ts  Files

Y Filters X SEndpointloghy... View Certificates

No Threat Detected

2. Click Scan on the confirmation pop-up.

Scan All with OPSWAT X

Files matching the filter criteria and downloaded to this endpoint server will
be included in the scan. Select endpoint broker to include files downloaded to
other endpoint servers.

Note: Time needed to scan will depend on the number of files that need to be
scanned.

==

View OPSWAT Scan Results

The scan results will be displayed under theOPSWAT STATUS column on theFiles tab as follows:
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- - File is infected

- - Suspicious file

- Scan failed; see troubleshooting section for more information.

¢ The file is clean as of the last scanned time.

- - Not yet scanned.
Click on a file to view scan results under theFILE DETAILS panel.

e Scan Time: States the last scanned time.

o Scan details: States whether a file is infected or suspicious or no threat detected, names of anti-
malware engines that identified the threat.

RSA ve d osts )as! (0} S ®  admin

Y Filters S Endpointloghy... View Certificates “® Change File Status 4 Analyze Events | $ More Actions v B

P FILE DETAILS
[ FLENAME  Risk ScoRe onmosTS ¢ size DOWNLOADED  OPSWAT STATUS vARA sTATUS REMEDIATION repUTA &

8 56MB - -

5 237.0KB No Threat Detected - - Show details with values only

AT

4 61.0KB Not Matched =

Time  06/09/202112:02:58.473pm
90.0KB No Threat Detected Not Matched

68.0KB No Threat Detected Not Matched

Suspicious (eset)
Eicar test file

33.0kB No Threat Detected Not Matched

Suspicious (ahnlab)
EICAR Test File
Suspicious (bitdefender)
EICAR Test File
Suspicious (clamav)
EICAR Test File

csrss.exe 17.4KB Not Matched
No Threat Detected Not Matched

20.8KB No Threat Detected Not Matched

111.3KB Not Matched

525KB Not Matched = ScanTime  06/09/202107:24:26808 am

1105KB No Threat Detected

CL LKL L KK

37.2KB

[m]
o
o
o
o
o
=1
u] O 4725K8
o
o
[m]
o
o
o
[m]

Alerts and Impact on Risk scores

Alerts: Critical alerts will be triggered when OPSWAT finds a file as infected, and High severity alerts
when a file is found suspicious.

Risk score: If a file is found infected or suspicious by OPSWAT, the risk score of that file and the
corresponding host will be increased.
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R S/\ Iny U Hosts Files D, 2 5 © ® admin

7 Filters © Endpointloghy... View Certificates “® Change File Status 4 Analyze Events | $ More Actions v/

FILE DETAILS RISK DETAILS
FILE NAME RISK SCORE ONHOSTS ¥ SiIZE DOWNLOADED  OPSWAT STATUS YARA STATUS REMEDIATION

ALERTS SEVERITY
8 56MB = -

5 237.0KB No Threat Detected = - 2

61.0KB Not Matched - CRITICAL

90.0KB No Threat Detected Not Matched
68.0KB No Threat Detected Not Matched
33.0KB No Threat Detected Not Matched
csrssexe 17.4KB Not Matched
4725KB No Threat Detected Not Matched
20.8KB No Threat Detected Not Matched
111.3KB Not Matched
525KB Not Matched

1105KB No Threat Detected

L L L LKL LCS LKL KL K

37.2KB

00 0|0 0 0| 0ONSe 0O 0 0 0|0|0(0

49.0KB

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:

1. Go to Files.

2. View the details of the file name and hash from the table MD5, SHA1, and SHA256 columns, or
view the details in the File Details tab on the right panel.

3. Select one or more files, and right-click or in the More Actions drop-down list in the toolbar, do the
following:

R S/\ nv E d osts Files R 3 & % (©) admin >

Y Filters ‘ S endpointloghy... ‘ View Certificates & Change File Status % Analyze Events ‘ v ‘ % More Actions B

SAVED FILTERS O FILENAME RISK SCORE T FIRSTSEENTIME  ON HOSTS REPUTATION SIzE SIGNATURE PE.RESOURCE... FILE STATUS

Select Known Good 95MB  microsoft;signedyalid MicrosoftCor... Neutral

Change File Status

. Known Good 1439.. microsoftsignedyalid Microsoft Cor... Neutral

FILE NAME

Analyze Events

Equals e.g. Filename.d Known Good 362.7... microsoftsignedyalid MicrosoftCor... Neutral
4 Google Lookup ok

I STE VirusTotal Lookup Known Good 6590... microsoftsignedyalid Microsoft Cor...  Neutral

O Neutral View Certificates Known Good 567KB  microsoftsignedyalid MicrosoftCor... ~Neutral

O Blacklist
O Graylist Download File to Server Known Good 802.6... microsoft;signedyalid MicrosoftCor... ~Neutral

O Whitelist
Known Good 135KB  microsoftsignedyal... MicrosoftCor... Neutral

REMEDIATION L Known Good 7475... microsoftsignedyal... MicrosoftCor... Neutral

ckex -
= Bl Reset Risk Score 5
Known 815KB  signedyalid VMware,Inc.  Neutral

a. Select Google Lookup and perform a search on the filename, MD5, SHA1, or SHA256.
b. Select VirusTotal Lookup and perform a search on MD5, SHAT1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.
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Set Files Preference

By default, the Files view displays a few columns and the files are sorted based on the risk score. If you
want to view specific columns and sort data on a specific field:

1. Go to Files.

2. Select the columns by clicking £ in the right-hand corner. The following example shows the drop-
down list displayed while adding columns:

On Hosts
File Status
Remediation
Reputation

Downloaded

Signature

irst Seen Time

3. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Files view.

Export Global Files

To extract the list of global files to a comma-separated values (csv) file:

Note: While filtering on a large data set, use at least one indexed field with the Equals operator for
better performance. You can export up to 100k files at a time.

1. Go to Files.

2. Filter the files by selecting the required filter option.

3. Add columns by clicking E°3 in the right-hand corner.
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4. Click to export the files to a csv file.
RSA Files Da

Y Filters X S endpointloghy... || View Certificates “® Change File Status || ¢ AnalyzeEvents | v || § MoreActions v

e e FILE NAME RISKSCORE 1 FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PERESOURCES... FILE STATUS

Select ) 06/11/2020 17:05:... Known Good microsoftsignedvalid  Microsoft Corpo... Neutral

R 06/11/202017:05:... Known Good 39..  microsoftsignedyalid  Microsoft Corpo.. Neutral
Equals 06/11/2020 17:05:... Known Good ics ignedyvalid Mi rpo... Neutral
e sarus 06/11/202017: Known Good microsoft signedyalid  Microsoft Corpo... Neutral
O Neutral o) 06/11/2020 17:05-. Known Good microsoft.signedyalid  Microsoft Corpo... Neutral
06/11/202017:05:.. Known Good microsoft signedyalid  Microsoft Corpo... Neutral

06/11/2020 17:05-... Known Good microsoft signedyalid... Microsoft Corpo... Neutral

You can either save or open the CSV file.

Analyze Certificates

Note: The information in this topic applies to RSA NetWitness Platform Version 11.3 and later.

The Certificates view provides a list of code-signing certificates reported by hosts found in your
deployment and their associated properties. You can select the certificates under a specific Endpoint
server.

To view the certificates in an Endpoint server:
1. Go to Files.

2. From the drop-down menu, select the Endpoint server to view certificates present on that server. To
view a consolidated list of certificates, select the Endpoint Broker server.

3. Select a file and do one of the following:
RSA

¥ Filters ‘ View Certificates

TGS [ FLENAME  RISKSCORE T FIRSTSEENTIME ONHOSTS  REPUTATION SIGNATURE PERESOURCE... FILE STATUS
Select 0 (0)  oeny20179.. Known Good microscftsigredyalid  Microsoft Cor...  Neutral

FILE NAME Known Good microsoftsignedyalid  Microsoft Cor...  Neutral

Change File Status

Equals Known Good .7... microsoftsignedvalid Microsoft Cor...  Neutral

Analyze Events
Known Good microsoftsignedyvalid - Microsoft Cor...  Neutral

FILE STATUS Google Lookup

Known Good microsoftsignedyalid ~ Microsoft Cor...  Neutral
- VirusTotal Lookup ’ 2
lacklis

0 Graylist View Certificates .. Known Good microsoftsignedvalid ~ Microsoft Cor...  Neutral
0 Whitelist
Download File to Server .. Known Good microsoftsignedyval.. Microsoft Cor...  Neutral

REMEDIATION Known Good microsoftsignedyval.. Microsoft Cor...  Neutral
0 Blocked
Known signed,valid VMware, Inc. Neutral

REPUTATION
0 Malicious

Reset Risk Score 0. Known unsigned = Neutral
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o Right-click and select View Certificates from the context menu.

¢ Click View Certificates in the toolbar.

Change the Certificate Status

You can assign a Whitelist status to the certificate signed by certain trusted vendors and this status can
be automatically applied to all files that is signed by this certificate. If you consider abc a trusted vendor,
you can set the status for the certificates signed by abc as Whitelist.

Similarly, you can also set the certificate status as Blacklist or Neutral. If a company's certificate is
stolen or compromised, you can blacklist this certificate and remediate.

To change the certificate status:

1. Select a certificate, and click Change Certificate Status.

Change Certificate Status

CERTIFICATE 5TATUS

is applied to all files
O Blacklist
O Whitelist
O Neutral

COMMENTS

Enter comments

Cancel

2. In the Change Certificate Status dialog, select a status - Blacklist, Whitelist, or Neutral.

Note: If you have manually updated a file status in the Files or Hosts view, changing the status in
the Certificate view does not impact the file status as the manual update takes precedence. For
example, if you have whitelisted the file vmci.sys that is signed by VMware, Inc. in the Files or
Hosts view, and you have blacklisted VMware, Inc. in the Certificate view, the file vmci.sys
remains Whitelisted though the certificate is blacklisted.

3. Add a comment and click Save.

4. Click < Files to go to the Files view.

Note: In a multi-server environment, changing the status of a certificate in one endpoint server updates
the respective files in other endpoint servers. For example, if a certificate status is set to Blacklist on
one endpoint server, all files signed by this certificate are set to Blacklisted on all endpoint servers.
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Filter Certificates

You can filter certificates on status, signature, friendly name, and thumb print.

Y Filters < Certificates # Change Certificate Status ¥ Analyze Events .

FRIENDLY NAME STATUS ISSUER THUMB PRINT NOT VALID BEFORE UTCDA1 3

Microsoft Windows Pu_.  Neutral C=US5, 5=Washington, L=Redmond,. 99922da31f07202edb07cdBbé0a. 2018-06-06T 18:57:34. 000+0000

99922da31f07a02edb07cd8b60a137144

“ aved Showing 1 out of 1 certificates | 1 selected

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters list. To delete a filter, hover over the name, and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Resetting Risk Score of Files

You can reset the risk score for a file in these situations:

 If the alerts or events triggered by the host or a file are considered to be false positive, you can make
required changes to the Endpoint Application rules or ESA rules.

» After you take required action on a malicious file.

When you reset the risk score, the risk calculation for the file is deleted and score is set to 0. The risk
score on all the hosts on which this file exists is recalculated. You can reset the risk score for a single file
or multiple files.

To reset the risk score of a file:
1. Go to Files.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more files and do one of the following:
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Y Filters 8 endpointloghy... \ View Certificates “® Change File Status || ¢ AnalyzeEvents | v || § More Actions v ‘

SAVED FILTERS FILE NAME RISKSCORE  © FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PERESOURCES... FILE STATUS

Select ) 06/11/202017:05.. 2 Known Good 9.5MB N Microsoft Corpo... Neutral

ITERANE ) 06/11/202017:05-. Known Good 1439 Microsoft Corpo... Neutral

o
o
o
Equals o ) 06/11/2020 17:05:... Known Good 3627.. microsoftsignedyalid  Microsoft Corpo... Neutral
= Known Good 6590..  microsoftsignedyalid  Microsoft Corpo... Neutral
Change File Status

Known Good 56.7KB microsoft,signedyalid Microsoft Corpo... Neutral
Analyze Events

Known Good 8026.. microsoftsignedyalid  Microsoft Corpo... Neutral
Google Lookup o L

VirusTotal Lookup ¢ Known Good 135KB  microsoftsignedyalid... Microsoft Corpo... Neutral
MrELEii e Known Good 7475..  microsoftsignedvalid,.. MicrosoftCorpo.. Neutral
Download File to Server :05:.. 2 Known 815KB signedyalid VMware, Inc. Neutral
Known 595KB  unsigned - Neutral

Known 1113..  signedyalid Microsoft Corpo... Neutral

Known 1600...  unsigned VMware, Inc. Neutral

06/11/202017:05:. Known Good 1450..  microsoftsignedyalid... Microsoft Corpo... Neutral

06/11/202017: Known Good microsoft signedyalid,.. Microsoft Corpo... Neutral

06/11/202017: Known Good 2 microsoft;signedyalid  Microsoft Corpo... Neutral

m}
o
o
o
o
m}
m}
o
m]
m}
m}
o

06/11/2020 17:05-. Known Good 8380..  microsoft;signedyalid,.. Microsoft Corpo... Neutral

Showing 100 out of | 1 selected

¢ Right-click and select Reset Risk Score from the context menu.

¢ Click More Actions > Reset Risk Score in the toolbar.

All the alerts associated with the score are deleted.

Note: You can select a maximum of 100 files to reset the score.

4. Refresh the page to view and confirm if the file's score is reset. This may take sometime for changes
to take effect.
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Note: The information in this topic applies to RSA NetWitness Platform Version 11.3 and later.

The Hosts view allows you to investigate on a host, which includes scan details, tracking events related
to alerts, anomalies, and process details.

Best Practices

The following are some best practices and tips that may help you investigate efficiently to identify and
isolate threats or attacks:

Analyze Events
Analyze Hosts (Navigate or Events g
View)
- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files Perform Host
Highest Risk Score Forensics

- Search on Snapshot

Change File Status Remediate

- Analyze Processes Perform Extemnal

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate

- Analyze Risky Users (Users View) Host fi P
ost from Netwo

* Review hosts with highest risk score and analyze the alerts contributing to the risk. Review the
entities, such as file name, processes involved in the alerts. For more information, see Analyze Hosts
Using the Risk Score.

» Review files or processes that created this suspected file, and check if any other files are accessed or
created in the Events view. For more information, see Analyzing Events.

* Review hosts for rare files in the On Hosts column. If a file is present on 100 hosts, it can be
legitimate. If a file is present on fewer hosts with a high risk score, it may be malicious and needs
further investigation.

o Filter to exclude hosts on host status, risk score, hostname, and so on. For more information, see
Filter Hosts.

» Search Google or VirusTotal with the file hash and review any reported activities. For more
information, see Launch an External Lookup for a File.
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Review the processes, autoruns, files, libraries, drivers, and system information. For example,
e Search for files in known malware locations. For example,

¢ C:\Windows\.

¢ C:\Users\<name>\AppData\<uncommon folder>.

e (C:\Users\<name>\AppData\Local\Temp.

¢ C:\Windows\Temp\.

o Search for a particular file name or hash and review the snapshot to check when the file was first
seen.

e Review any network connections established by the process, such as:
¢ Domain or IP address.

e Ports used (common (80 and 443) versus uncommon ports (8080 , 8888, and 3465)) and check if
the ports are listening actively.

¢ Check the file compile time. If the date is recent, it could be malicious.

Check the file creation time on the host.

Review reported anomalies, such as suspicious threads, kernel hooks, image hooks, and registry
discrepancies. For more information, see Analyze Anomalies.

Launch Process Analysis to view the sequence of activities performed on the host by the file or
process. For more information, see Analyze Processes.

Download suspicious files to the server for deeper analysis. For more information, see Analyzing
Downloaded Files.

Download MFT, process, or system dump to the server for forensic investigation. For more
information, see Performing Host Forensics.

After investigation if a file is found to be malicious you change the status of the file (blacklist or
graylist) and block infected or malicious file. For more information, see Changing File Status or
Remediate.

(Optional) If you suspect that a host is potentially compromised with the threat still being active, you
can isolate the host from the network and safely investigate possible threats within the host. For more
information, see Isolating Hosts from Network.

View Hosts

You can view all hosts present on a specific Endpoint server or consolidated list of all hosts on multiple
Endpoint servers using the Endpoint Broker for analysis. By default, hosts are sorted based on the risk
score. To view the hosts:

. Go to Hosts.

2. Select from the following:
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¢ Endpoint Broker Server to view all hosts across all Endpoint servers. When querying, the
Endpoint Broker ignores Endpoint servers that are offline. If the Endpoint server is online but is
not responding, the Endpoint Broker waits for 10 seconds, and ignores if it does not respond.

« Endpoint Server to view hosts on a specific Endpoint server.

LAST SCAN TIME
05/05/202005:59:16 pm

05/06/202007:38:30

05/06/202007:47:47am  WINB1X64-1\AdministratorWindow Manager.. ~a

Ubuntu 18.044LTS 05/05/202001:07:05pm  kslp

Red Hat Enterprise Linux 8.1 (Ootpa) 05/06/202007:20:35am  kslp

3. Select a host that you want to analyze.
4. Click a row to view the following details:

¢ Host Details displays the host information such as Network Interfaces, operating system,
hardware and others.

¢ Risk Details displays the distinct alerts associated to the risk score and the alerts severity. Click
Critical, High, Medium, or All to display all the alerts. For more information, see Analyzing

Risky Users.
Click Show next 100 hosts to view other hosts.

6. Click the host name to investigate the scan results. For more information, see Analyze Host Details.

View Agent History

You can view the list of commands issued to the agents (by the server or actions performed by any
analyst) in the Host view and Host details. By default, commands are sorted based on the command time.

To view the commands:
1. Go to Hosts.

2. Do any one of the following,

To view all commands, click . You can also filter commands, for more information see Filter

Hosts.

8 endpointbrok... E\é

[0 HOSTNAME RISKS.. AGENTLAST.. AGENTSCANST.. AGENTGROU.. AGENTMODE  AGENT VERSION  AGENT-D.. AGENT - INSTALLTIL. AGENT ID LASTSCANTI 5}

The Agent History view is displayed. For more details, see Analyze History.
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¢ To view commands specific to a particular host:
© Click the host for which you want to view the commands.

° In the Host details view, click History tab. You can also filter commands, for more information
see Filter Host Details.
The History view is displayed. For more details, see Analyze History.

o Hosts [l Dashboar

(] AGENT SCAN STATUS AGENT LAST SEEN AGEN
Scanning 2daysago 115

AUTORUNS ~ FILES ~ DRIVERS  LIBRARIES ~ ANOMALIE ) ADS  SYSTEM INFO

History

@) custompate | COMMAND TIME £ COMMAND TYPE HOST NAME USER NAME STATUS COMMAND PARAMETER PROCESSED TIME LAST RETRIEVAL TIME

06/15/2020 08:06:29 am Download File system 06/15/2020 08:06:35 am

02007:18:47 a

06/08/202007:18:47 am

Contains

system

v
v
v
v
v
v
v
v
v
v
v
v

system

Filter Hosts

You can filter hosts on agent version, agent ID, agent mode, agent upgrade, agent last seen, last scan
time, operating system, hostname, username, Mac address, risk score, IPV4, driver error code, security
configurations, agent groups, and host status - managed, roaming, and isolated.

In the Host view > click , to filter the commands on command type, status, host name, request type,
command parameter and command time. In the Command Time field, you can filter by custom date

range.

Note: While filtering on a large amount of data, use at least one indexed field with the Equals
operator for better performance. The following fields are indexed in the database - Hostname, [Pv4,
Operating System, Last Scan Time, and Risk Score.
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R S A e ‘ ) Users Hosts

SAVED FILTERS - HOSTNAME RISK SCORE AGENT VERSL.J- LAST SCAN TIME

Select

HOST STATUS

O Managed (0) 6.0, 09/29/202004:36:32 ...

O Roaming

09/29/202004:22:54 ...
O 1solated

RISK SCORE

11600 A
11600 ® 09/28/2020 08:34:35 ...

09/29/202005:01:05 ...

HOSTNAME

Equals

USERNAME

Equals

Showing 100 out of 1000+ hosts | 0 selected

To search multiple values within a field, set the filter option to Equals, and use | | as a separator.

For example, using Equals operator for multiple IPV4 values with a separator | |.
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Y Filters

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals v e.g.,00:00:00:00:00:00

IPV4

Equals +  10.87.225.68]|10.40.7.11

AGENT LAST SEEN

LAST SCAN TIME . CUSTOM DATE

OPERATING SYSTEM
O windows

O Linux

0 Mac

ACENT MO

To filter on the agent last seen or last scan time, select the option from the drop-down list. If you select 3
Hours ago for the Last Scan Time, the result displays hosts that were last scanned 3 hours ago or earlier.

To filter on the risk score, use the slider to increase or decrease the values between 0 to 100.
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Y Filters

RISK SCORE

HOSTNAME

Equals v Enter value

USERNAME

Equals v Enter value

AGENT GROUPS

Equals v Enter value

NIC MAC ADDRESS

Equals v e.g.,00:00:00:00:00:00

IPV4

Equals v eg,1.1.1.1]]1.1.11

AGENT LAST SEEN

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click .

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

To filter the agents based on the upgrade status, select one of the upgrade statuses. For example, select
the Upgrade Available checkbox to get the list of agents available for an upgrade.
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Y Filters

AGENT LAST SEEN @ ) customparte

LAST SCAN TIME @ ) custompare

OPERATIN STEM
O Windows

O Linux

0O Mac

AGENT UPGRADE

O Failed

O Pending
Upgrade Available

AGENT MODE
O Insights
O Advanced

AGENT-

Equal

SECURITY CONFIGURATIONS

To filter the agents based on single or multiple agent groups, select a group from the drop-down list. You
can also search the name of the groups from this list.
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Y Filters

HOSTNAME

Equals

USERNAME

Equals

AGENT GROUPS

(<alres) - Growin

linuxGrps
pureLinuxGrps
WindowsAndLinuxGrps
LinuxRhelGrps

Equals

AGENT LAST SEEN @ ) custoMDATE

Save Save as...

To filter the agents based on the installation status, select one of the installation statuses. For example,
select the Uninstalled checkbox to get the list of agents for which the uninstall is initiated or
successfully completed.
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Y Filters

O Failed
O Pending
O Upgrade Available

AGENT MODE

O Insights
O Advanced

AGENT INSTALLATION STATUS
O Installed
Uninstalled

AGENT- DRIVER ERROR CO

Equal

SECURITY CONFIGURA’

AGENT ID

Equals

AGENT VERSION

Equals

You can also filter the commands on command type, status, host name, request type, command

0

parameter and command time (In which you can filter by custom date range), by clicking :®

Adding and Sorting Columns in the Table

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. To
add or remove columns:

1. Go to Hosts.

2. Select the columns by clicking 3 in the right-hand corner.
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3.
4.

Username

Agent Version

Scroll down or enter the keyword to search for the column.

Click the arrow on the column header to sort the column in ascending or descending order.

Scan Hosts

You may want to perform an on-demand scan if you want to get the latest snapshot of the host.

When hosts are scanned, the Endpoint Agent retrieves the following data that can be used for
investigation:

Drivers, processes, DLLs, files (executables), services, autoruns, anomalies, host file entries, and
scheduled tasks running on the host.

System information such as network share, installed Windows patches, Windows tasks, logged-in
users, bash history, and security products installed.

To start a scan:

1. Go to Hosts.

2. Select one or more hosts (up to 100) at a time for an on-demand scan, and do one of the following:
¢ Right-click and select Start Scan from the context menu (or) click Start Scan from the menu bar
o Click Start Scan in the dialog.

3. Click Start Scan in the dialog. This performs a quick scan of all executable modules loaded in
memory.
The following are the scan statuses:
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oy ool ¢

Idle No scan is in progress.

Scanning  Scan is in progress.

Pending Scan request is sent to the server and the agent will receive the request the next time
it communicates with the server.

Cancel Stop request is sent to the server and the agent will receive the request the next time it
communicates with the server.

Analyze Hosts Using the Risk Score

You can investigate a host by analyzing the risk contributors such as alerts and events to look for
suspicious or malicious activity.
To analyze the hosts using the risk score:
1. Go to Hosts.
The Hosts view is displayed.

2. In the Server drop-down list, select the Endpoint server or Endpoint Broker server to view the hosts.

3. Select the host and do any of the following.
¢ Click a row to view the risk associated with the host in the Risk Details panel.
¢ Click the hostname to investigate the host.
4. In the Alert Severity panel, click the alert severity such as Critical, High, Medium, or All.
The list of distinct alerts is displayed along with the total number of events associated with the alert.

5. Click an alert to view the associated events.

2 10 13

caimica T

@ Events rolled over due to retention policies or manual deletion will not be available.
18 events HOST DETAILS ~ POLICY DETAILS

EVENT TIME EVENTTYPE CATEGORY ACTION HOSTNAME USER ACCOUNT OPERATING SYSTEM HASH rlist
03/01/2019  Endpoint Process Event createProcess windows Oedas8l
02:34:08.000

Enables Cleartext Credential Storage (1) pm

Users
1 eventis) FILE NAME LAUNCH ARGUMENT PATH

Show details with values only

Enables Login Bypass (18) souRcE  malwarel.exe malware10.exe -dllioc.dil testcase:400,401 CiUsers\ecat\Desktop\:

18 event(s) TARGET REG.exe REG.exe ADD "HKLM\SOFTWARE\Microsoft\Windows C:\Windows\system32\
gT\Curr\e(g\[V?rﬂon\\r}ﬂage Flllegxg(uuon/ REG.SZ/d
tions\displayswitch.exe” /v Debugger /t ¢ true
"é?\wmdawf\syyssremzzmmd.exe" Vs
s Administrators
EVENTTIME  EVENTTYPE CATEGORY ACTION HOSTNAME USER ACCOUNT OPERATING SYSTEM HASH
03/01/2019  Endpoint Process Event createProcess windows Oedasl
02:34:08.000 Users
pm
FILE NAME LAUNCH ARGUMENT PATH

SOURCE  malware10.exe malware10.exe -dll:ioc.dll -testcase:400,401 CAUsers\ecat\Desktop\

TARGET  REG.exe REG.exe ADD "HKLM\SOFTWARE\MicrosoftWindows  C:\Windows\system32\
ntVersion\image File Execution

utilman.exe” /v Debugger /t REG_SZ /d

ws\system32\cmd.exe” /f

Intel(R) PRO/1000 MT Networ...
EVENT TIME EVENTTYPE CATEGORY ACTION HOSTNAME USER ACCOUNT OPERATING SYSTEM HASH

03/01/2019  Endpoint Process Event createProcess windows Oedas8l
02:34:08.000
pm P4 10407.16

Note: Only the latest 1000 events are displayed.

6. To view all the metadata associated with a specific event, click the event header. The information
such as source path, target path, filename, and others is displayed.
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@ Events rolled over due to retention policies or manual deletion will not be available:

18 events
10 13 25

ueoum AL 03/01/2019 Endpoint

02:34:08.000 pm

Process Event

SOURCE
PATH

Enables Login Bypass (18) CUsers\ecat\Desktop\

18 events) FILE SHAZS6
(Oeda8ba34ddc46909c66cebasbc231f029dedbe
0992a1eb31130b794134c55db
FILENAME
malware10.exe
LAUNCH ARGUMENT
malware10.exe -dll:ioc.dll -testcase:400,401

DEVICE

USER
USERNAME

WIN-NMUFVI3DGTN\ecat

HASH
Oeda8ba34ddc46909c66cebasbc231f029dedbe
0992a1€b31130b794134c55db

RELATED LINKS

evenT TV evenTTvee cATEGORY Acrion
createProcess windows

HosTNAME USER ACCOUNT OPERATING SYSTEM

TARGET DOMAIN/HOST

C\Windows\system32\
= size

FILE SHA256 M
193160426600b776d9b2a0505903d8cbegf0ea
1520e9c2a7e6d5960b6faddcat

FILENAME
FILENAME malware10.exe
REG.exe

size
LAUNCH ARGUMENT M

e ADD
OFTWARE\MIUDSufll\Wlndow HASH
NT\Currentversion\image File Execution ‘Oeda8ba34ddc46909c66cebasbc231f029d
Optionsidsplayswich exe” v Debugger 1t e e
REG_SZ /d "C:windows\system32\cmd. exe" /f

oece AGENTID
93B4DD24-9103-9792-F9B5-FE141338C91

DEVICE TYPE

193160426600077609b2a05d5803d8chcBf0ea e

1520e9c2a7e6d5960b6laddcat

Oeda8ba34ddc46909c66eebasbc231f029dedbc0992a1eb31130b794134c55db.

EVENT SOURCE
10.40.14.52:50005

USER SRC
ALIAS IP
EVENT SOURCE ID

118794
USER

Hover over one of the meta values for IP, Hostname, Mac, File name, File hash, User, and Domain to
view additional information about the specific metadata. A hover box displays a list of the data
sources that have context data available for meta value. These are the possible data sources:

NetWitness Endpoint, Incidents, Alerts, Hosts, Files, Feeds, and Live Connect.

CONTEXT HIGHLIGHTS

0 0 0
INCIDENTS ALERTS LISTS

ENDPOINT CRITHCALITY ASSET RISK

View Context

ACTION
createProcess

HOSTNAME

To investigate the original event and destination domain of the event, do

ALERTS SEVERITY

2 10 13 25

| veium A

18 events

EVENT TIME
03/01/2019
02:34:08.000 pm

EVENT TYRE

CRITICAL HIGH Endpoint

Enables Cleartext Credential Storage (1)
1 eventls) SOURCE
PATH

C:\Users\» \Desktop\V

Enables Login Bypass (18)

18 events) FILE SHA256

Oeda8ba34ddc46909c66cebasbc231f029dedbc
10992a1eb31130b794134c55db

FILENAME
malware10.exe

LAUNCH ARGUMENT

malware10.exe -dll:ioc.dll -testcase:400.401

DEVICE

USER
USERNAME

HASH

Oeda8ba34ddc46909c66ceba: 5h(23'\ f029dedbc

0992a1eb31130b794134c55db

RELATED LINKS

ACTIONS

= Add/Remove from List

Q, Pivot to Investigate > Navigate
O, Pivot to Investigate > Hosts/Files
0, Pivot to Endpoint Thick Client

USER ACCOUNT

@ Events rolled over due to retention policies or manual deletion will not be available.

CATEGORY

HOSTNAME
Process Event -

createProcess

TARGET
PATH
C:\Windows\system32\

FILE SHA256

19316d4266d0b776d9b2a05d5903d8chcsf0ea
1520e9c2a7e6d5960b6faddcal

FILENAME
REG.exe

LAUNCH ARGUMENT

REG.exe ADD
"HKLM\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\image File Execution
Optionsidisplayswitch.cxe” /v Debugger /t

REG_SZ /d "C:\windows\system32\cmd.exe" /f

DEVICE

HASH

19316d4266d0b776d9b2a05d5903d8cbc8f0ea
1520e9c2a7e6d5960b6faddcaf

USER ACCOUNT

any of the following:

OPERATING SYSTEM
windows

DOMAIN/HOST

SIZE

4

DATA

FILENAME

malware10.exe

sIze

4

HASH

OedaBba34ddc46909c66cel bashc231f029d
edbc0992a1eb31130b794134c55db
AGENTID
93B4DD24-9103-9792-F985-FE6141338C91

DEVICE TYPE
nwendpoint

o To reconstruct an event in a readable form that matches the original, click the Investigate
Original Event link highlighted in blue. For more information on event reconstruction, see the

NetWitness Investigate User Guide.
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o For details about the elements associated with an event, click the Investigate Destination Domain
link highlighted in blue. For more information on Contextual Information for an Event, see the
NetWitness Investigate User Guide.

Note: Investigate Destination Domain link is not displayed if there is no domain.dst event.

o To view a list of processes captured on the hosts and investigate a particular process, click the
Analyze Process link highlighted in blue. For more information on process analysis, see
Investigating a Process.

Note: Analyze Process link is not displayed if there is no createprocess event.

Analyze Host Details

To look for suspicious files on a host, click the host name and view the details of the host, or start an on-
demand scan to get the most recent information. On the right-hand panel, you can view the following:

o Host Details displays the host information, such as Network interface, operating system, hardware
and others.

e Policy Details displays the complete resolved policy settings.

For more details, see Hosts View - Details Tab.

RSA Investig nd Users Hosts Files Da Re

100 : AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

SNAPSHOT TIME  06/24/2020 21:30:33

windows Idle afew seconds ago 11.5.00

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM R

ALERTS SEVERITY ® Events rolled over due to retention policies or manual deletion will not be :

28 events HOST DETAILS POLICY DETAILS
EVENT TIME EVENT TYPE CATEGORY ACTION HOST

CRITICAL 06/29/202013:40:54000  Endpoint  File
FILENAME Show details with values only

Blacklisted File (28)

Groups
28 event(s)

FILENAME LAUNCH ARGUMENT oups  Windows-security
Runs Blacklisted File (3) SOURCE
3event(s) TARGET

EVENT TIME EVENT TYPE CATEGORY  ACTION HOST
06/29/2020 13:40:54.000 Endpoint File

FIENAME  HASH
intl.dll 639ff2ef6bchaad 1796b83706... Gro Administrators
FILENAME LAUNCH ARGUMENT

SOURCE
TARGET

Filter Host Details

In the Processes, Autoruns, Files, Drivers, Libraries, and Anomalies tabs, you can filter the processes or
files on file status, reputation, file or process name, signature, and risk score. Click Save to save the filter
and provide a name (up to 250 alphanumeric characters). The filter is added to the Saved Filters panel on

the left. To delete a filter, hover over the filter name and click W
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In the Host view > Files tab, you can filter the files available on host, and files deleted from host. The
result of files deleted from host depends on the data retention policy configured in the Endpoint Config
view > Data Retention Scheduler tab. By default, data retention policy is configured for 30 days, this
means only 30 days of deleted files are stored in the Endpoint server. These filter options are disabled if
All Files Available on Host toggle is disabled.

In the Host view > History tab, you can filter the commands on command type, status, host name,
request type, command parameter and command time. In the Command Time field, you can filter by
custom date range.

Click Save to save the filter and provide a name (up to 250 alphanumeric characters).The filter is added
to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click .

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Search Files on Host

To investigate a host or to check if it is infected with a known malware, you can search for occurrences
of the file name, file path, or SHA-256 checksum.

Note: To search for a SHA-256 checksum, provide the entire hash string in the search box.

The result displays the matching files present on the host in All Files Available on Host category and in
the respective snapshot category with the details, such as file name, signature information,and
checksum. In addition, the snapshot category displays the system interaction, for example, ran as
process, library, autorun, service, task, or driver. To view more details, click the filename or system
interaction link.

Example, a user has clicked and executed a malicious attachment through a phishing email, and
downloaded it to C: \Users. To investigate this file:

1. Goto Hosts.

2. Select the host that you want to investigate or select the Endpoint Broker server to investigate all the
hosts.

3. In the Details tab, enter the file path C:\Users in the search box.

The search displays a maximum of 100 results of the executables in this folder. In this example, the
file Malware.exe, is an unsigned file that might be malicious. If the search is executed on an
Endpoint Broker server, it queries all the Endpoint servers.
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4. To view details of this file, click Process in the result.
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This opens the Process tab where you can view the process details.

Analyze Processes

To analyze the process:
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1. In the Hosts details, select the Processes tab.

Hosts
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o
o
o
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o
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2. In the Processes Tab, do one of the following:
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o Click a row to view the properties of a process in the right panel.

Hosts F Das
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R SA Hosts Files [BE!
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DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HISTORY

< Processes | Process Details

PATH

C:\Windows\System32\

When reviewing processes, it is important to see the launch arguments. Even legitimate files can be used
for malicious purposes, so it is important to view all of them to determine if there is any malicious
activity.

For example,

* rundll32.exe is a legitimate Windows executable that is categorized as a good file. However, an
adversary may use this executable to load a malicious DLL. Therefore, when viewing processes, you
must view the arguments of the rund1132.exe file.

e LSASS.EXE is a child to WININIT.EXE. It should not have child processes. Often malware use this

executable to dump passwords or mimic to hide on a system (1lass.exe, 1ssass.exe,
lsasss.exe, and so on).
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e Most legitimate user applications like Adobe and Web browsers do not spawn child processes like
cmd. exe. If you encounter this, investigate the processes.

You can view the sequence of activities performed on the host by the file or process using the process
analysis. For more information, see Investigating a Process.

Analyze Autoruns

In the Hosts details, select the Autoruns tab. You can view the autoruns, services, tasks, and cron jobs
that are running for the selected host.

For example, in the Services tab, you can look for the file creation time. The compile time is found
within each portable executable (PE) file in the PE header. The time stamp is rarely tampered with, even
though an adversary can easily change it before deploying to a victim's endpoint. This time stamp can
indicate if a new file is introduced. You can compare the time stamp of the file against the created time
on the system to find the difference. If a file was compiled a few days ago, but the time stamp of this file
on the system shows that it was created a few years ago, it indicates that the file is tampered.

Analyze Files

To analyze the files, you can do either one of the following based on your requirement.

e In the Hosts view, select the Files tab.
You can view the list of all files (reported as part of scan and tracking) on the host including the
deleted files.

Hosts

@ 3 AGENT sCAN

AGEN
Scanning 2 days ag

sNapsHoT TiME  06/20/2020 06:30:11 am
DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES [ SYSTEM INFO  HISTORY

Y Filters X es @ ALL FILES AVAILABLE ON HOST

T FILENAME LOCAL RISK SCORE GLOBALRISK SCORE  ON HOSTS FILE STATUS REPUTATION DOWNLOADED PATH
Equals o) Neutral Known Good - C:Windows\Systen

e srargs Neutral Known Good - CAWindows\s,

O Neutral (o) ©O) Neutral Known Good - C:AWindows\SysWOW64\
Neutral Known Good - C:Windows\Microsoft NET\asser
Neutral Known Good C\Windows\System32\

Neutral Known Good

Neutral Known Good

Neutral Known Good

Neutral Known Good

Neutral Known Good

Neutral Known Good CAWindows\S)

e To view the files reported as part of scan snapshot, you must disable All Files Available On Host
toggle and select the scan time form the Snapshot drop-down list.

Example for analyze files, many trojans write random filenames when dropping their payloads to prevent
an easy search across the endpoints in the network based on the filename. If a file is named
svchOst.exe, sevhost.exe, Or svchosts.exe, it indicates that the legitimate Windows file named
svchost.exe is being mimicked.
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Analyze Libraries

In the Hosts details, select the Libraries tab. You can view the list of libraries loaded at the time of scan.

For example, a file with high entropy gets flagged as packed. A packed file means that it is compressed
to reduce its size (or to obfuscate malicious strings and configuration information).

Analyze Drivers

In the Hosts details, select the Drivers tab. You can view the list of drivers running on the host at the
time of scan.

For example, using this panel, you can check if the file is signed or unsigned. A file that is signed by a
trusted vendor such as Microsoft and Apple, with the term valid, indicates that it is a good file.

Analyze Anomalies

Note: This tab is available only for advanced agent.

In the Hosts details, select the Anomalies tab. You can view the following details for the selected host:

* Image hooks - Hooks found in executable images (user-mode or kernel-mode) - IAT, EAT, Inline,
exceptionHandler.

e Kernel hooks - Hooks found on kernel objects (such as Driver Object [Pointers, IRP_MJ, SSDT, IDT,
and so on]). This also includes filter devices.

 Suspicious threads - Threads whose starting address points to memory DLLs or floating code. The
threads could be running with either user-mode or kernel-mode privileges. These threads could run
malicious code inside a trusted application to execute their own code.

» Registry discrepancies - The Windows registry is a hierarchical database that stores configuration
settings and options on Microsoft Windows operating systems. It contains settings for low-level
operating system components and for applications running on the platform: the kernel, device drivers,
services, SAM, user interface, and third party applications all use the registry. The discrepancies
between low-level parsing with Win32 registry API are reported.

Note: Anomalies is applicable only for Windows hosts.

For example, hooking is used to intercept calls in a running application and to capture information
related to the API invocations. Malicious programs can implant hooks in various system applications for
different purposes, such as hiding files, directories, registry entries, intercepting users keystrokes to
establish a stealthy communication channel with the attacker.

Analyze System Information

In the Hosts details, select the System Information tab. This panel lists the agent system information.
For Windows operating system, the panel displays the host file entries and network shares of that host.

For example, malware might use host file entries to block antivirus updates.
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Analyze History

In the Host details, select the History tab. This tab lists the commands along with the respective status
and additional details.

When you review the history, look for the command status and retrieval count to check if the agent
retrieved the commands.

Below are some examples:

e A file download command is issued, but the file is deleted on the host. In this case status of the
command is failed as the file is not downloaded.

» The retrieval count increases, but the command is not processed. This happens when an analyst
requests a large number of files (For example, MFT, system dump, or process dump), and the
connection breaks when the agent uploads these files.

» If the agent command is not retrieved, the agent is either offline or busy processing other commands
(For example, uploading a system dump). In this case, the status of the command shows pending.

To view more details, click the Hostname link highlighted in blue. The Hosts details view is displayed.
In the case of MFT, download file, system dump, and process dump command types, Downloads tab is
displayed with details such as file name, type, status, size, downloaded time and SHA256 of the file,
when you click on the Hostname link.

Export Host Details or Files to JSON File

Note: Export Host details option is disabled if there is no snapshot time.

To export host details or files to JSON file:
1. Go to Hosts.

2. Select the hostname to open the host details.

3. Click i (More) beside the hostname and do any of the following:

e To export the scan data categories for the host, select Export Host Details. This exports files
such as:

° allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on
that is reported as part of scan and tracking.

o fileContext.json - This file consists of the file name, file path, signature, file checksum, and so
on that is reported during the host scan.

° machinedetails.json - This file consists of the machine details, including hardware, operating
system, interfaces, and so on, along with the agent details like version, policy details.

Note: If Endpoint Broker is selected and a host is communicated with multiple Endpoint servers,
during the host details export, all files and details of the host are exported from the Endpoint server
where the selected snapshot is stored.
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Note: allfiles.json file is exported irrespective of the selected snapshot.

e To export all the files available on the host, select Export Files. This exports:

o allfiles.json - This file consists of the file name, file path, signature, file checksum, and so on
that is reported as part of scan and tracking.

Launch an External Lookup for a File

While analyzing a file, you can search Google or VirusTotal with the filename or hash to get more
information about the file. To launch the search:

1. Go to Hosts > Host Details (Autorun, Files, Drivers, Libraries, or Anomalies tab).

2. Right-click one or more files, or in the More Actions drop-down list in the toolbar, do the following:

RSA Irvestip Hosts Fles T s B % 0O ann)

100 : AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

e sewsendsapp 11500 snapsrorTive  06/24/202021:30:33

windows

DETAILS ~ PROCESSES ~ AUTORUNS ~ FILES ~ DRIVERS  LIBRARIES ~ ANOMALIES ~DOWNLOADS  SYSTEMINFO  HISTORY

Y Filters X Processes @ meeview

PROC [ PROCESS NAME LOCAL RISK SCORE GLOBALRISKSCORE ~ ONHOSTS REPUTATION FILESTATUS  DOWNLOADED FILE PATH

Coas 0 m 7 iG] Bckited - C:Windows\Syslen

FILE STATUS = Known Good Blacklisted - C:Windows\System3

0 Neutral MBI
o Known Good Neutrl h C:Windows System3
0 Blacklist Change File Status

0 Graylist Anaivze Evenls Known Good Neutral - C:Windows\System3d
O Whili 4

Google Lookup Known Good Neutral - C:Windows\System3
REPUTATION
0 Malicious
0 Suspicious Download Process Dump to Server P—— Neutral - C:Windowsiystend
0 Unknown
0 Known Download File to Server Known Good Neutral - C:\Windows\System3
0 Known Good
0 Invalid

VirusTotal Lookup Known Good Neutral - C:Windows\System3

Known Good Neutral - C:Windows\System3

Known Good Neutral - C:Windows\System3

Known Good Neutral - C:\Windows\System3

¢ Select Google Lookup to perform a search on the filename, MDS5, SHA1, or SHA256.
¢ Select VirusTotal Lookup to perform a search on MD5, SHA1, or SHA256.

Note: To open files in multiple tabs, make sure you enable the pops-up in the browser.
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Delete a Host

If the agent is uninstalled on a host or if you no longer require the host scan data, you can manually
delete this host from the Hosts view. Deleting a host deletes all scan data associated with the host. To

delete hosts:
1. Go to Hosts.

2. Select the hosts that you want to delete from the Hosts view and do one of the following:

RSA
Y Filters

SAVED FILTERS
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O Roaming

O Isolated

RISK SCORE

0

HOSTNAME

Equals

Hosts  Files ashboards  Reports

X € endpaintbrok... v [ Analyze Events Start Scan

[0 HOSTNAME RISK5CO.J  OS - DESCRIPTION LAST SCAN TIME
O 100 Microsoft Windows 10...  06/28/202021:30.08

06/24/202021:30:33
Analyze Events

06/28/202014:30:22

Delete

Start Scan

Network Isolation

Download MFT to Server

Download System Dump fo Server

Download Files to Server

Reset Risk Score

¢ Right-click and select Delete from the context menu.

EYd N
0]

2

USERNAME AGENT LASTSEEN | AGENTSCANSTA.. AGEN (3}

admin >

WINDWOS...  afewsecondsago  Scanning Windows-s
WINDOWS... ndsago  ldle Windows-s

afewsecondsago  Idie

e Click More drop-down list in the toolbar and select Delete.

Note: If you accidentally delete a host from the Hosts view, the Endpoint Server forbids all requests
from this agent. The agent must be uninstalled manually from the host and reinstalled for it to appear
on the Hosts view.

Deleting Hosts with Older Agent Versions

After upgrading the 11.1.x and 11.2.x agents to 11.3 or later, if you want to delete the hosts with older

versions:

1. Go to Hosts view.

2. Filter the hosts based on the Agent version, and delete these hosts.

If you do not delete, the hosts are deleted based on the Data Retention Policy settings.
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Set Hosts Preference

By default, the Hosts view displays a few columns and the hosts are sorted based on the risk score. If
you want to view specific columns and sort data on a specific field:

1. Go to Hosts.

2. Select the columns by clicking 3 in the right-hand corner. The following example shows the drop-

down list displayed while adding columns:

Hostname

Risk Score

3can Time

Username

Agent Version

3. Scroll down or enter the keyword to search for the column in the displayed list.

4. Sort the data on the required column.

Note: The selections you make here become your default view every time you log in to the Hosts
view.

Export Host Attributes

You can export up to 100,000 host attributes at a time. To extract the host attributes to a csv file:
1. Go to Hosts.

2. Filter the hosts by selecting the required filter options.

3. Add columns by clicking £3 in the right-hand corner.
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4. Click to export the host attributes to a csv file.

Hosts

¥ Filters X S endpointbrok...

HOSTNAME RISKSCORE & OS- DESCRIPTION LAST SCAN TIME USERNAME
.. 05/08/20200221:35pm  Window Manage\DWM-2WIN1909-64B-Ole... ~ afer
05/05/202005:59:16pm oot

05/06/202007:38:30 am root

05/05/202001:07:05pm  kslp

05/06/202007:20:35 am kslp

o
o
o
o
o (= icros nterprise 05/06/202007:47:47am  WINB1X64-1\AdministratorWindow Manager
o
o
o
=]

You can either save or open the csv file.

Migrate Hosts

Hosts can be migrated from one Endpoint server to another using groups and policy associated with the
host. If a host is migrated, the Server column shows as Migrated. On all the tabs within the Hosts view,
the message Host is migrated to <Server-name> is displayed. You view the host details by clicking the
<Server-name>. The risk score of a migrated host is displayed on all Endpoint servers where it is
present.

Note: Some of the actions are disabled for the migrated host on the selected server, such as start scan,
start stop, analyze events, and others. If you want to perform the required action, select the Endpoint
server to which the host is migrated.

Note: To view only managed hosts, select the Show Only Managed Agents option in the Filters
panel.

Analyzing Risky Users

If you have NetWitness UEBA installed, you can view the alerts associated with users logged in on the
host. To analyze risky users:

1. Go to Hosts.
2. Click the host name you want to analyze.

3. In the Host Details panel, under the Users category, click the name.
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This opens the Entities tab for investigation in a new tab.
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Resetting Risk Score of Hosts

You can reset the risk score for a host in these situations:

windows

ore

vsTEM
windows

HOST DETAILS

values only

Windows-security

D 2

Administrators

 If the alerts or events triggered by the host or files on the host are false positive, you can make

changes to the Endpoint Application rules or ESA rules.

o After you take required action on the host for malicious file activities contributing to the risk score.
When you reset the risk score, all the risk calculation for the host is deleted. When you reset the host's
risk score, it does not change the file's risk score. You can reset the score for a single host or multiple

hosts.

To reset the risk score of a host:
1. Go to Hosts.

2. Select the Endpoint Server or Endpoint Broker.

3. Select one or more hosts and do one of the following:
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J Start Scan

HOSTNAME RISK SCORE 4  OS5- DESCRIPTION LAST SCAN TIME

N/A Microsoft Windows 10 Pro for Workstati.. 05/08/2020 02:21:35 pm

Red Hat Enterprise Linux- 7.2 05/05/202005:59:16 pm

Red Hat Enterprise Linux- 7.2 05/06/2020 07:38:30 am

Microsoft Windows 8.1 Enterprise 05/06/2020 07-47-47 am
Delete

Start Scan

Ubuntu 18.04.4 LTS 05/05/202001:07:05 pm
Red Hat Enterprise Linux 8.1 {Ootpa) 05/06/2020 07:20:35 am
Microsoft Windows 10 Education

Reset Risk Score
Microsoft Windows 7 Enterprise

¢ Right-click and select Reset Risk Score from the context menu.

¢ Click More Actions > Reset Risk Score in the toolbar.

All the alerts associated with the score are deleted.

Note: You can select a maximum of 100 hosts to reset the score.

4. Refresh the page to view and confirm if the host's score is reset. This may take sometime for changes
to take effect.
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Investigating a Process

Note: The information in this topic applies to RSA NetWitness Platform Version 11.3 and later.

Analysts can perform process analysis to investigate a particular process behavior to:

* Understand the entire process event chain, process parent-child relationships, and all associated events
in a timeline view.

* Analyze important process attributes, such as username, launch arguments, reputation, file status,
signer, signature, risk score, and file path.

The Analyze Process view provides a list of processes captured on hosts in a parent-child hierarchical
format over a time range. The process tree is created from the tracking event type "Process event" where
the action meta key is createProcess. The agent reports new events for the same createProcess if the
following parameters change:

» Parent process filename
e Child process filename
e Launch arguments

e User name

If the above parameters do not change, the event is reported only once every eight hours.

Best Practices

When reviewing a host for malicious activity, there are a few key things to review while looking for
malicious processes.

e Process Name - When reviewing running processes on a host, check for the name of the program that
looks suspicious. Sometimes malware uses random names, such as wzuduje.exe. In some cases, the
names might be misleading such as adob3.exe, scvhost.exe, or Microsoft.exe. Being familiar
with Windows processes and any type of internal tool that might be used throughout the environment,
also helps you to identify potentially malicious or suspicious files.

o File Path - Similar to knowing normal and key Windows processes, knowing what path the processes
originate from is a key to detect certain processes that imitate the legitimate process. For instance, if
you see svchost.exe running on a system from
C:\Users\<username>\AppData\Roaming\adobe\ (which is a valid file path), and knowing
that the legitimate Windows process originates from C: \Windows\System32\, you can determine
that the svchost . exe file starting from the C:\Users\<username>\AppData\Roaming\adobe\
directory is the suspicious one. To help determine further identification of a suspicious process,
review the Autoruns tab to see if this process is running as an autorun, service, or task.

« File Signature - When a software package is created, it has a valid digital signature. The following are
a few exceptions:

e [f a process that is running is not digitally signed, it does not automatically confirm that the file is
malicious.

61 Investigating a Process



NetWitness Endpoint User Guide

* While files may have a valid signature, it does not mean that they are legitimate. There are

instances of software identified as a Potentially Unwanted Program (PUP) or Adware, which can
have a valid signing certificate.

On Hosts - Indicates the number of hosts on which a file exist. If a file is present on fewer hosts with
a high risk score, it may be malicious and needs further investigation.

Reputation - Leveraging the reputation service is a way to find malicious processes.

Analyze events - For further insight to a process, you can analyze console events, network events, file
events, process events, and registry events.

Network events - Look for any suspicious domains to which the process is connecting. Sometimes
malware creates legitimate connections to a known site, such as google.com, bing.com to hide its
activity on the network. Look for connections to Dynamic DNS domains where a lot of known
malicious activity resides. During analysis, consider uncommon processes making direct
connections to an IP address or to a uncommon port number.

File and process events - Review process interactions that have occurred on the system with the
suspected file. You can look for key events such as writeToExecutable, renameExecutable,
and createRemoteThread, which indicate suspicious behavior.

Leverage other methods

Look up with Google - You can search the file name or hash value against Google to determine if
the file is malicious.

Look up with VirusTotal — You can search the hash value against the VirusTotal to determine if the
file is malicious between multiple AV vendors.

Download file — Download and analyze a file to find indicators such as compile time, imported
DLLs, section names, and performing string searches. Look for TLD values (.com, .net, .biz) or
debug information of a compiled binary (.pdb), which can be easily changed or forged.

Time stamp values — Review modified, accessed, and created dates associated with the binary.
Review how long a file has been residing on a host. While this value is correct most of the time,
attackers can change the time stamp values of a file.

Analyze a Process

Note: Linux is not supported for analyzing a process.

To analyze the process:
Go to Hosts.

1.
2.
3.

Click the hostname.

To analyze process activities of a file, do one of the following:

¢ In the Host Details tab:

a. Click the alert severity.
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The list of distinct alerts is displayed along with the total number of events associated with the

alert.

b. Click the event header and click the Analyze Process link at the bottom.

o Seclect the Processes tab and do one of the following:

- Right-click a process and select Analyze Process from the context menu.

- Click Analyze Process in the toolbar.

In the following example, the file powershel1l has invoked mimikatz, which is a tool to extract
plain text passwords, hashes, and kerberos tickets from memory.

afewsecondsage 11400

DETAILS  PROCESSES ~ AUTORUNS  FILE LIBRARIES  ANOMALIES  DOW|

ALERTS SEVERITY

3

CRITICAL

Jevents
11/29/201909:59:25000am  Endpoint

C\Windows\System32\

edadaldadSacs77a81bSbbed 128e
'20abfa3715465ad66edScd

‘cmd.exe c\Suspicious bat C\Suspicious.ps1

11/11/201902:41:06 pm

SYSTEM INFO  HISTORY

) Events rolled over due to retention policies or manual deletion will not be available.

ProcessEvent  createProcess

CAWindows\system32\

19316d4266d06776d9b230545903d8cbeaf
0Oeal1520e9c2a7e6d5960b6faddcat

regexe
REG ADD HKCU\Environment Av
UserInitMprLogonScript /tREG_MULTI SZ /d

"CATMP\mim.exe sekurisa-LogGnPasswords
> C\TMP\o.txt*

193160426600b776d9b2305d5903d8cbeBf
0eal1520e9c237e6d5960bofaddcat

15837032

F6D99DB2-9DF2-3FBF-5CTE-66FBADBIODIS
fwendpoint

10125244.230:50005

Clicking Analyze Process displays the process visualization. For each node, the process name, risk

score, and type of activity the selected process has performed (network , file , or registry )
are displayed. Optionally, you can change the time range to view data.

You can view the properties, such as process execution details, file properties of the selected process

in the bottom of the view.
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00.000 pm rs 0 23rTho4 il iconPresent fileversionl...

Suspicious.ps1 | 617 4040KB Crmd Exe . rdata_data, pdata, didat, rsrc. reloc

Note: No result is displayed in the process visualization view if there is no data for last seven days
or if there is no createprocess event.

4. On the right side of the process visualization view:

¢ Click Events List to view the associated events. You can also filter events based on the events
category. For more information on filtering, see Analyze Events for a Process.

¢ Click Hosts to view the hosts on which this file is present and the associated risk score. For more
information, Analyze Hosts with File Activity.

¢ Click Risk Details to view the list of distinct alerts, such as Critical, High, Medium and All. For
more information, see Analyze Hosts Using the Risk Score.

5. Hover over the process name to analyze important process attributes, such as username, launch
arguments, reputation, file status, signer, signature, and file path.
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NT AUTHORITY\SYSTEM

Signed

cwindows\system 32,

cmil.ee c\Suspicious bat
c\Suspscious.psl
(3 Copy Launch Arguments

6. Click @ to view the child processes. The Process selection dialog is displayed with the child
processes associated with the process based on the risk score. You can filter the result on the event
type by clicking icons on the top panel. When no matching event types are available, these filter
options are disabled.

Depending on the type of event, the icons are highlights in the Event Types column.

a. Click View All to view all child processes or select the required processes and click View
selected. The associated events and properties are displayed in the right panel.
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e . © |
b. Click to change the process selection and click to collapse the view.

Al(70) @ Network{12) OFie(s
PROCESS NAME RISE SCORE LAUNCH ARGUMENTS EVENT TYPES

omid exe /i certutil exe -uricadhe -spiit - httpsfraw__ I

o exe
oonhost s (bd T -Forcehfl

omd e o dir /b /&-d Mest-set=\"oollecfion™"hat
ping-n5 127001

Tzee e-bbl -paptsimulsior “Cmimieizenc-files
Tz e-bbl -paptsimulstor “C\mimiatenc-files

omd e fic dir /b /a-d Mest-sets\"oommand-and-con__
Showing 70 out of 70 | 70 selected

0
o
0
0
0
0

70 Process selected Cancel View all View Selected

Analyze Events for a Process

To analyze events for the selected process:

1. Perform steps 1 to 3 in Analyze a Process.

2. In the process visualization, click the Events tab.

3. To narrow down the search to find any suspicious indicators, behaviors, or specific type of event,
filter on a set of matched events based on a category - Process, File, Registry, Network Event, or
Console Event (for Windows).
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For example, to view only process events, select the Process Event category, and filter on action.

EVENT TIME CATEGORY

14,7 AP 065.. Prox et

11703:0..  Process Event

Process Event

Process Event

Process Event

Process Event

Process Event

ACTION

openfr._.
openPr_..
openPr_.
openPr_.
openfr._.
openPr_..
openPr_.

openPr_.

openfr._.

openPr_..
openPr_.

openPr_.

Events Liat

SOURCE FILE NAME
explorerexe
explorer.ave
explorer.eve
explorer.axe
explorerexe
explorer.ave
explorer.ae
explorer.axe
explorerexe
explorer.ave
svrhost e

lsazz.eve

SOURCE PARAMETER SOURCE DIRECTORY
C\Wincows',
C\Wincows',
C\Windows',
CWindows',
CWYindows',
C\WWindows',
C\Windows',
CWindows',
C\Wincows',
C\Wincows',

svrhast exe -k netsves -p CWindows! System 32,

C\Windows! System32,

The result displays the sequence of activities involving this process for the selected filters.

from 11.4 or later agents.

Note: For the console events, the context for local and remote are available only if the data is sent
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Note: By default, the blocking option is disabled in the policy. To enable blocking, in the policy
configuration, change the Blocking option to Enabled under Response Action Settings. For more
information, see the NetWitness Endpoint Configuration Guide.

To change the status of a file:

1. Do one of the following:
¢ Go to Hosts (Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tab).
¢ QGo to Files.

2. Select one or more files and do one of the following:

RSA te  Respond  Users osts  Files  Dashboards  Reports (¢ ® admin>
Y Filters x 8 endpointloghy... v View Certificates “ Change File Status | | 7 Analyze Events )|

S AVEDEITTERS [0  FILENAME RISK SCORE 7 FIRSTSEENTI.. ON HOSTS REPUTATION SIZE  SIGNATURE PE.RESOUR..  FILE

Select O) 06/11/202017... Known Good 95MB  microsoftsigned,.. MicrosoftC...  Neutral

FILE NAME Change File Status > . Known Good 143..  microsoftsigned,.. MicrosoftC.. Neutral
AV

Analyze Events

Equals Known Good 362... microsoftsigned,.. MicrosoftC...  Neutral

Google Lookup
Known Good 659....  microsoftsigned,.. MicrosoftC...  Neutral

FILE STATUS VirusTotal Lookup

o glleuitl.a\ View Certificates Known Good 56.7... microsoftsigned,.. MicrosoftC...  Neutral
acklist

O Graylist Download File to Server
O Whitelist

Known Good ... microsoftsigned,..  MicrosoftC...  Neutral
Known Good .5...  microsoftsigned,..  MicrosoftC...  Neutral
REMEDIATION PO = Known Good ... microsoftsigned,.. MicrosoftC...  Neutral

O Blocked
Reset Risk Score b Known 5. signedyalid VMware, Inc. ~ Neutral

¢ Right-click and select Change File Status from the context menu.

¢ Click Change File Status in the toolbar.
3. In the Change File Status dialog, select a status - Blacklist, Whitelist, Graylist, or Neutral.
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Change File Status

STATUS
Blacklist
CATEGORY

Select

REMEDIATION

enabled and terminates a

ed file hashes

ISA and Mi =0ft cannot be blocked.

O Graylist
O Whitelist
O Neutral

COMMENTS

Cancel

Note: You cannot whitelist certain Microsoft files, such as cscript.exe, wscript.exe,
cmd.exe, bash.exe, as there is a potential risk of them being used for malicious purposes. For
more information, see Files Restricted from Whitelisting.

If you select Blacklist or Graylist, the following options are displayed:

a. Category: Select the appropriate category type: Generic Malware, APT: Advanced Persistent
Threats, Attacker Tool, Unidentified, Ransomware.

Caution: Before blocking, make sure that you review the file because this may cause the
system or software to be unusable.

b. Remediate: Select Block to block the file.

Note: Blocking is supported only for Windows hosts.
You cannot block the following:

- Memory DLL and floating code

- Files that are signed by Microsoft or RSA.

4. Add a comment and click Save.
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You can change the status of only 100 files at a time. When the status is changed, it impacts the file
status on all hosts on which the file is present. The status is sent as a session under the File category, and
available for investigation. If the file is seen in subsequent scan or tracking, the corresponding sessions
contain a meta value with the file status (except Neutral).

Files Restricted from Whitelisting

To view or update the files that are restricted from whitelisting, do the following:

1. On the NW server, run the nw-shell command from the command line.
2. Run the 1ogin command and enter your credentials.
3. Connect to the Endpoint Server using the following command:
connect endpoint-server
4. Run the following commands to view the list of files:
e cd endpoint/file/status/restricted/get
e invoke Whitelist
5. Run the following commands to add files to the list:
e cd endpoint/file/status/restricted/get
e invoke '{"id":"<filename>","restrictedStatus":["Whitelist"],
"enable":true}
6. Run the following commands to delete files from the list:
e cd endpoint/file/status/restricted/update
e invoke '{"id":"<filename>","restrictedStatus":["Whitelist"],
"enable":false}
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Analyzing Downloaded Files

To perform a deep analysis of suspicious files, you can manually or automatically download the file to
the server.

Note: Saving or analyzing downloaded file works the same way irrespective of whether the file is
downloaded manually or automatically.

Note: Downloaded files are stored in the Endpoint Server which may fill up the disk space. To utilize
the storage efficiently without impacting the health of Endpoint Server, RSA recommends you to
configure an external storage mount, so all the Endpoint Server can use the configured location to
store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<files>/. If you
want to change the location, make sure that you have endpoint-server.configuration.manage
permissions and do the following:

1. In the Explore view, go to endpoint/download,

2. In the base-path, provide the location of the directory.

Caution: By default, the status File Download Disk Usage stats in the Health and Wellness view
shows unhealthy if the disk usage reaches 60% and the file download stops automatically when the

disk usage is 70%. You can customize the warning or fatal thresholds in the O > Services >

Endpoint Server > view > Explore > rsa.endpoint.file-download-disk-thresholds.warning-percent
and rsa.endpoint.file-download-disk-thresholds.fatal-percent parameters respectively.

For the downloaded file, you can:

» Search for strings in the executable

* View text content for scripts

e View imported libraries and functions

e Save a local copy for further analysis

Download Files to Server

Downloading file to server is not supported for memory DLL and floating code.

Note: Downloading files may take significant time. Additional requests to the agent during download
are queued and processed when the download is complete.
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Automatic File Download

By default, the files that are unsigned and size lesser than or equal to 1 MB are downloaded
automatically to the NetWitness Endpoint server. And, only single copy of each file is downloaded

7

automatically. You can limit the volume of files to be downloaded in the O > Endpoint Sources
> Policies tab, so the files matching certain criteria are only downloaded automatically. For more
information on automatic file download settings, see "Create an EDR Policy" section in the

RSA NetWitness Endpoint Configuration Guide.

The status of the download is displayed in the Files tab > Downloaded column.

Manual File Download

To manually download files to the server from the Hosts view:
1. Go to Hosts.

2. Select the hostname to open the Host Details view.

3. In any of the Processes, Autoruns, Files, Drivers, Libraries, or Anomalies tabs, select the file, and do
one of the following:

RSA e

3 AGENT AGENT LAST SEEN AGENT VERSION
100 e e e poyde swapsoTTvE  06/28/202021:30:08

DETAILS  PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

¥ Filters X | Processes | €7 AnalyzeProcess ||  Change FileStatus | | o Analyze Events |+ | 3 More Actions v @) rrecview

O PRrOCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE ON HOSTS REPUTATION FILESTATUS  DOWNLOADED FILE PATH

Known Good Blacklisted - C:\Windows\System3}
Analyze Process

Known Good Blacklisted - C:\Windows\System3]
Change File Status

Analyze Events (©O) Known Good Neutral - CaAWindows\Systems3:
Google Lookup (O) 2 Known Good Neutral - CAWindows\System3:

VirusTotal Looku
v Known Good Neutral - C:\Windows\System3:

Crrr s eI Known Good Neutral - CAWindows\System3:
Download File to Server (o) Known Good Neutral - CAWindows\System3:

Known Good Neutral - C:AWindows\System3:

0O 00|00 0/ 0|0

Known Good Neutral - CAWindows\System3:

¢ Right-click and select Download File to Server from the context menu.

¢ Select Download File to Server from the More Actions drop-down list in the toolbar.
To download files to the server from the Files view:
1. Go to Files.

2. Select the file and do one of the following:
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RSA estigate  Respond  Users osts  Files  Dashboards  Reports

Y Filters - © endpointbrok... ~ ‘ View Certificates %% Change File Status H O AnalyzeEvents | v || # More Actions v

SAVED FILTERS O ruename RISKSCORE 7 FIRSTSEENTIME  ONHOSTS REPUTATION siZE  siGNATURE PERESOURCES... FILESTATUS
Select u] 06/12/202011:16:... Known 171.. - Neutral

i nAmE Known 89.6KB v VMware, Inc. Neutral
Change File Status

Known 9084... - Neutral
Analyze Events

Known 256.0. Neutral
Google Lookup
VirusTotal Lookup S Known Good 1375..  microsoft,signedyalid,.. Microsoft Corpo... Neutral

View Certificates Known Good 741KB  microsoftsignedyalid  Microsoft Corpo... Neutral
Download File to Server : Known Good 353KB  microsoftsignedyalid  Microsoft Corpo... Neutral

Known 141KB  unsigned - Neutral

Known 26KB - Neutral

u}
u}
o
o
o
u}
u}
u}

Reset Risk Score Known Good 6272 signedyal Microsoft Corpo... Neutral

¢ Right-click and select Download File to Server from the context menu.

¢ Select Download File to Server from the More Actions drop-down list in the toolbar.

The status of the download is displayed in the Downloaded column. The download statuses are
Downloaded, Not downloaded, and Error.

Save Downloaded Files

You can retrieve a downloaded file and save it to your local file system for further analysis. Downloaded
files are stored in the server in the configured location. This option is enabled only if the file is
downloaded to the server.

To save a file:
1. Go to Hosts or Files .
2. Right-click the file you want to save and select Save a Local Copy.

3. Browse the location and click Save.

Analyze Downloaded Files

You can use the Analyze File option to view detailed information about a downloaded file. This option
is enabled only if the file is downloaded to the server. To analyze a file:

1. Go to Hosts or Files.

2. Right-click the downloaded file and select Analyze File. The File Analysis view opens and
properties of the are is displayed in the right panel.
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Cmd.Exe Details  Ana

ACTIVEON  SIGNATURE size FILESTATUS  OPERATING SYSTEM
70 0 micrasoft signed,valid,catalog ~ 227.5KB  Neutral windows

File Al -5 v FILTER STRINGS  EN

DETAILS
STRING OFFSET UNICODE LENGTH

usebackq 0x00027C88

XAy 0x0000C64A

Show details with values only

NtOpenProcessTokes 0x0002DFEQ File Details

fE9d 0x0001F9AA y e
e sestetl 0x00020184 4f684066175b77€0c3a000549d2922¢
99ae9c73e9bee6fac76d6f4093a9882d1068...

935c1861df1f4018d698e8b65abfa02d7e90...

wescmp 0x0002E0BC

IdpiAware 0x00030C8F
227.5KB

952d%s%! %s902d 0x00027ECO eName  935c1861df1f4018d698e8b65abfa02d7e90...
AcquireSRWLockShared 0x0002D202 varinetwitness/endpoint-server/files/935¢c1
0x00030B00

0x0001FE72 AMD64/x64

0x0002: 4 ExecutableLarge Address Aware
07/16/2016 07:53:21.000 am

0x00012488 0x00015190

0x00028C48
0x0000D10C

Wwindows Console
0x00027CD0

3. View strings in the file in the Strings view while analyzing an executable (such as macho, pe, elf).
This view contains the string, offset in the binary, unicode, and the length of the string. You can
search for or filter on a specific string value in the Filter String field.

4. View the text content of the file and look for any suspicious behavior in the script file.

For example, if the file contains C2 information in the form of domain names or IP addresses, it is
highly suspicious.

oo [ o525
1 idie 5 B o 11/12/2019 05:53:25 pm

ExEd]
DETAILS PROCESSES AUTORUNS FiLes DRIVERS LiBRARIES ANOMALIES DowNLOADS SvYsSTEM

ile Analysis - Stri s m3

sTRING orrser umicope LenaTH
0x00000407 v 19
000000496 v 2
000000828 v 2
t pe
16£277c8d94437b751917087ddc8d91
1 60ec5ca33072dff849a1d9eacda6c20834ad...
5 b266afb334f3dec596dace50170994c8f942.
OKB
< b266afb334f3decs960ac6501170994c942..

Nar/netwitness/endpoint-server/files/b266a

86/x86
= Executable.Large Address Aware
< 017142019 10:20:25.000 am

© 0X00002C4A

n Windows Console

Showing 3 of 123 strings

If you see unprintable keyboard keys listed within the file, such as: [F1], [F2]...[Page Up], [Enter],
[ESC], and so on, that may be indicative of a keystroke logger.
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idie

100

11/12/2019 05:53:25 pm
windows

keEviog|
PROCESSES  AUTORUNS LIBRARIES  ANOMALIES DOWNLOADS  SYSTEM

< Files | | Fi View  ruren strines

DETAILS
stainG orrser unicoe LenaTH DETAIL
el 0x00055070 s

[E=d 0x00055128 Show details with values only

[Right] 0x00055068 File Details
0x0004612F pe
000061510 5242de7eee306123c50c1d0dcad83062
dacca0cf0edbadsScdce6s15e506209C8f18.
0x00055050
9eb0aadOeaa22685a6aceaa24136298472.
0x00056100
401.0KB
s D c9ebaad0eaa22685a6aceaa24136e98472...
fsOni* 0x0005C2F4 Nar/netwitness/endpoint-server/files/coeb0
TCTKISTITnS: 0x00062015

[PageDown] 0:0005511C 1386/x86

=1 e Executable,32-bit
[thunk: 0x00056610 02/22/2019 11:46:23.000 am
01,101at 0X000275FF
S50
3
Windows Console

[Num Lock] 000055218

[End] 000055060

Showing 29 of 1510 strings
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Performing Host Forensics

Note: The information in this topic applies to RSA NetWitness Platform Version 11.4 and later.

You can perform the following forensic investigation on a host:
* Master File Table (MFT)
e System Dump

e Process Dump

Note: This is applicable only for Windows agent (in Advanced mode) with NetWitness Platform
version 11.4. Downloading system dump files may take significant time. Additional requests to the
agent during system dump download are queued and processed when the download is complete.

MFT, system dump, and process dump downloads are not supported for agents communicating through
Relay server.

Note: MFT, system dump, and process dump are stored in the Endpoint Server which may fill up the
disk space. For large deployments, to utilize the storage efficiently without impacting the health of
Endpoint Server, RSA recommends you to configure an external storage mount, so all the Endpoint
Server can use the configured location to store the downloaded data.

By default, all files are downloaded to /var/netwitness/endpoint-server/<file type>/,
where <file type> is MFT, system dump, or process dump. If you want to change the location,
make sure that you have endpoint-server.configuration.manage permissions and do the following:

1. In the Explore view, go to endpoint/download.

2. In the base-path, provide the location of the directory.

Download Master File Table

Master File Table contains metadata of every file on the host. It keeps track of information, such as
filename, size, timestamps, permissions, and location of the file on the host. It consists of two sets of
timestamps - Standard Information ($SI) and File Name ($FN). Each set has the following timestamps -
creation, access, update, and modification.

Time stomping is a technique that modifies the timestamps for a file (creation, access, update, and
modification time) to mimic files that are in the same folder, making it difficult to identify suspicious
files on a host. To perform forensic investigation of a suspicious file, you can download and analyze the
MFT, and focus on files that are time stomped. For more information, see Analyze Downloaded MFT.

During MFT analysis, you can also search for suspicious filenames, and also files that were created
before or after a known malicious event. You can also download files from the MFT viewer for further
analysis.

Download MFT to Server

To download MFT to the server from the Hosts view:
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1. Go to Hosts and do one the following:

o Select a host and select Download MFT to Server from the right-click context menu, or from the
More Actions drop-down list in the toolbar.

x S endpointbrok... & Analyze Events ® Stop Scan i MoreActions EE)

Reset Risk Score
HOSTNAME ¢ RISK SCORE AGENT 1D,
Delete
° Download MFT to Server CBDDF1D7-1343-9664-1040-9EAEB7868681
|

Dt o e e D 3 Seavest BOBAD2CE-96C0-2CBF-BEFC-31FA289A5223

Download Files to Server ® 89A2B44A-76BC-2F44-ABB6-85ABDFOBDEBY

Stop Scan

Upgrade Agent ® BC7DCE60-95AD-8F 9E-FB D4001D9
Download MFT o Server N

Uninstall Agent 6F7008E4-OF 18-4A7B-BC70-3FBFDBC34AB6
6daysago 11510 5CFE11DCF91D-43C5-BIFA-FBD464DF7A4F
6daysago 11510 F5489124-E77E-402D-A636-9AD3553DD477

6daysago 11510 861361D8-AB24-4EFF-9F2A-FOCDA3144026

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Download MFT to Server.

RSA

MT LAST SEEN
ew seconds ago 11.5.00

100

windows

Start Scan

Export Host details
DETAILS PROCESSES BRARIES ANOMALIES

Export Files
ALERTS SEVERITY kd over due to retention policies

1 Network Isolation

i EVENT TYPE
CRITICAL Download MFT to Server 014:02:41.000  Endpoint

Download System Dump to Server ) N
ILE NAME LAUNCH

Blacklisted File (91)

91 event(s) Download Files to Server

2. In the Download MFT to Server dialog, select one of the following:

¢ Choose Select Drive to download MFT on assigned drive.
You can select the drive from the Drive drop-down list. By default the selected drive is C.

¢ Alternatively, you can choose Specify NTFS mount path to download MFT on the path to the
folder where it is mounted

Click Download.
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Download MFT to Server

Download MFT of a volume by selecting its assigned drive or path to the
folder where it is mounted.

Select Drive O Specify NTFS mount path

DRIVE

C

Cancel Download

3. View details of the downloaded MFT in the Downloads tab within the host details. For more
information, see Hosts View - Downloads Tab.

ENT SCAN STATUS AGENT LAST SEEN AGENT VE

Idle afew seconds ago 11500
DETAILS ~ PROCESSES  AUTORUNS  FILES  DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY
¥ Filters X Downloads

NAME DOWNLOADED  SIZE DOWNLOADED TIME SHA256

) 197.3M8 7 minutes ago NA

> C:\Users\"\NTUSER DAT = = 24 minutes ago

> C:\Users\uumm exe\exe\"

> ev

> C\Users\'\

Analyze Downloaded MFT

You can use the MFT viewer to begin analysis where you can search for files based on file name, time
stamps, and identify files that are timestomped.

View MFT

To view the content of the downloaded MFT:

1. Go to Hosts.

2. Select the hostname to open the host details and select the Downloads tab.
Click the file name. The MFT viewer is displayed.

All available files are displayed in a tree view similar to the Windows Explorer in the All Files
folder. The Deleted Files folder contains a sequential list of all deleted files.
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RSA

a few seconds ago 114.00

100

windows

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS EYETEM INFO

< Downloads || 7 Filters | MFT Viewer

MFT-CAWINDOWS10-2019-11-14T06-47-52- 7772 ] NAME CREATION TIME ($FN)

~ B8 C: E NWE-Trace-Oclcbdt 11/12/2019 070203 pm

O inetpub
™P

NWE-Trace-Oaccrar 11/12/2019 11:54:16 am

NWE-Trace-Oacc bt 11/12/2019 1248:33am

Windows NWE-Trace-Of80.rar 11/12/2019 12:08:39 am

J Users

2 ProgramData
Program Files (x86)
$RecydeBin
Perflogs

[ Program Files

] $Extend

NWE-Trace-0f80.txt 11/11/2019 09-25:01 pm
NWE-Trace-Oa3c bt 11/11/2019 07-32:11 pm
NWE-Trace-Ocd4 - Copy.oct 11/11/2019 06:56:29 pm
NWE-Trace-1fc0.txt 111172019 05:44:35 pm

J Recovery
J Documents and Settings
System Volume Information

NWE-Trace-Ocd4.txt 11/11/2019 05:43:31 pm
NWE-Trace-0c30. txt 11/11/2019 05:42:05 pm

- 11/11/2019 05:03:16
DELETED FILES DataCollector01.csv pm

NWE-Trace-264¢ - Copy it 11/112019 252 pm
ALL FILES

DIO0DIO0O 0O 00 D00 0|0|0D)| 0O

NWE-Trace-264¢ txt 11/06/2019 09:38:24 pm

4. Click P4 to view the folder structure. Click the row to view the folder content.

The details of the MFT is displayed in the table. By default, the table is sorted on the creation time

($EN). If the $ST and $FN timestamps are different, the columns are highlighted in red (.)
indicating that it is time stomped.

Hosts
afewsecondsago 11400
PROCESSES 4 LIBRARIES  ANOMALIES SYSTEM INFO  HISTORY
< Downloads || ¥ Filters
MFT-CINGSMUDALPLAC 2019-11-29T09-10-45-37Z CREATION TIME ($FN) 4 CREATION TIME ($51) MOOIFICATION TIME (SFN) MODIFICATION TIME ($51) ACCESS TIME ($FN) ACCESS TIME ($51)

[ GitOriginFesture Branch
) Git Origin Master

11/10/201906:17:063m 11/11/201906:1706 3m 112019061706 3m 11/11/201906:47:06 3m

S T 11/07/201901:02:28om 11/07/201901:0238 pem
) DeepWeb 2015) IVTSAG]

Gt

B SMSAdvancedCient. confiomer 1810-chent-kbA. - 11/07/201901:01:54pm 1901:01:54pm 11/077201901:01:54 pm

SysintemasSuite 5 13077201 1912:5732pm

09/14/201911:54:023m 1911:54023m 09/14/2019 11:54023m 5 09/14/201911:5402 am

1901:5419pm 0 08/22/201901:5419pm 02/227201901:5419 pm

1901:5419pm 08/22/201901:5419pm 02/22/201901:5419 pm

0472672019 10:44:423m 087262019 10.44:423m 0672672019 10:44:42 3m

04/06/2019 053154 pm
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5. Select one or more files and click Download File to Server on the toolbar to download files to the
server.

Note: Downloading a folder is not supported and hence the option is grayed out for folders.

Filter MFT
You can filter files on file name, creation time ($FN), creation time ($SI), access time ($FN), access time
($S1), update time ($FN), update time ($SI), modified time ($FN), and modified time ($SI).

RSA  investigate  Respon: Deciissws  [Rosar

Hosts

71 g

N N STA AGEN N AGENT VER
windows Idle afewseconds ago 11400

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO

¥ Filters 3 < Downloads

MET-CNGSMUDALPLEC 2019-11-29T09-10-45-3172 CREATION TIME (SFN) 4 CREATION TIME ($51)

O Git Origin Feature Branch B 11/11/2019 06:17:063m 11/11/2019 06:17:06 3m
> O GitOriginMaster

> O Temp 11/07/2019 01:03:38 pm 11/07/2019 01-03:38 pm

O DeepWeb (2015)[YTSAG] B  SMSAdvancedClient configmgri810-clien. 14/07/201901:01:54 pm 11/07/2019 01:01:54 pm
> O Git

O SysinternalsSuite 11/07/2019 1257:32pm 11/07/2019 1257:32pm

» By 09/14/2015 11:54:02am 09/14/2019 11-5402am
O Intel
O Documents and Settings 08 ® 08/22/201901:54:19 pm 08/22/2019 01:54:19 pm

> O Windows

> O Recovery
> O Users B DiskCleanupVier 04/26/2019 10:44:423m 06/26/2019 10:44:423m

[ R [ 08/22/201901:56:19 pm 08/22/2019 01:54:19 pm
@) custompate
> [ ProgramData
> £ Program Files (x84)
> [ $RecydeBin

06/06/. 06/06/201% 05:31:54 pm

@ ) cusToMmDate

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

To filter, save, and delete MFT, see Filter Downloaded Files, Save Downloaded File, and Delete
Downloaded Files.

System and Process Memory Dump

To perform forensic investigation during an incident response, you can request a memory dump of a host
or a process running on the host. You can analyze these dumps using third-party tools, such as Volatility,
Rekall.

Download System Dump to Server

To download system dump to the server from the Hosts view:

1. Go to Hosts and do one the following:

o Select a host and select Download System Dump to Server from the right-click context menu, or
from the More drop-down list in the toolbar.
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R SA i d s Hosts Files D

Y Filters X B endpointbrok... [ Analyze Events Start Scan

O HOSTNAME RISK SCORE 4 OS5 - DESCRIPTION

NA Microsoft Windows 10 Pro for Workstati...

N/A Red Hat Enterprise Linux-7.2

Red Hat Enterprise Linux-7.2

“nterprise
Analyze Events
Delete

« 8.1 {Ootpa)
Start Scan

ducation

Network Isolation s fiterprise

:nterprise
Download MFT to Server

Download System Dump to Server
Download Files to Server

Reset Risk Score ducation

MICroSoTT WiNdows 7 Enterprise

o Select the hostname to open the host details and select Download System Dump to Server from
the More option besides the hostname.

RSA

100 - AGENT SCAN STATUS AGENT LAST SEEN d

B S— ew seconds ago 11.5.00

Export Host details
DETAILS PROCESSES LIBRARIES ANOMALIES

Export Files

ALERTS SEVERITY olled over due to retention policies

2 Metwork Isolation

i i Download MET 0 S AE EVENT TYPE
el wnioa O Server b02013:40:54000  Endpoint
Download System Dump to Server
Blacklisted File (28)
28 event(s) Download Files to Server

2. View the details of the downloaded system dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.

Download Process Dump to Server
To download process dump to the server:
1. Go to Hosts.

2. Select the hostname to open the host details.
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3. In the Processes, Libraries, or Anomalies tab, select Download Process Dump to Server from the
right-click context menu, or from the More Actions drop-down list in the toolbar.

RSA

AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

Idle afew seconds ago 11.5.0. SNAPSHOTTIME  06/24/2020 21:30:33

‘windows

DETAILS PROCESSES ~ AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO HIST

Y Filters Processes | 4 Analyze Process & Change File Status  AnalyzeEvents | v || 3 MoreActions \/ @ ) TREEVIEW

PROCESS NAME LOCAL RISK SCORE GLOBAL RISK SCORE  ON HOSTS REPUTATION FILE STATUS DOWNLOADED
CE S AIGTENEE 100 100 2 Known Good Blacklisted

/0 100 2 Known Good Blacklisted

O Neutral Analyze Process

O Blacklist Change File Status
0O Gray
O Whitelist

2 Known Good Neutral

i BT Known Good Neutral
Google Lookup Known Good Neutral

REPUTATION VirusTotal Lookup Known Good Neutral

O Suspicious Download Process Dump to Server 2 Known Good Neutral
O Unknown

0O Known Download File to Server Known Good Neutral
O Known Good

O Invalid

Known Good Neutral

Known Good Neutral

4. View the details of the download process dump in the Downloads tab within the host details. For
more information, see Hosts View - Downloads Tab.

To filter, save, and delete system dump or process dump, see Filter Downloaded Files, Save Downloaded

File, and Delete Downloaded Files.

The following are some errors you might encounter during system and process dump download:

Issue Explanation

Parameter is incorrect. The process for which the dump is requested might be
running with a different process ID.

Element not found The process for which the dump is requested is no longer
active.

java.io.IOException:Unable to unwrap data, Connection to the agent is interrupted.
invalid status [CLOSED]

java.net.SocketTimeoutException The network is slow or the system is down.
One or more arguments are not correct Agent might be in the Insight mode or driver is not
running.

Download Files Using Full Path or Wildcard

You can manually download files that help in investigations by either providing full path of the file or
using wildcard.

Note: This is applicable only for agents in Advanced mode with NetWitness Platform version 11.5 and
later.

To download files to the server:
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1. Go to Hosts and do one of the following:

o Select one or more hosts from the same operating system, and select Download Files to Server
from the right-click context menu, or from the More Actions drop-down list in the toolbar. You
can download files from only top 100 selected hosts at a time.

RSA
Y Filters © endpointbrok... “ & AnalyzeEvents | v || @ StartScan # More Actions v/

[ HosTNAME RISK SCORE © OS - DESCRIPTION LAST SCAN TIME USERNAME AGENT LAST SEEN AGENTSCANSTATUS  AGENTGROUPS 1PV

AVED FILTERS
100 Microsaft Windows er.. 06/28/202021:30:08 .. afewsecondsago Idie Windows-security 10.125.245.1...

Analyze Events

. 06/24/202021:30:33 . afewsecondsago Idie Windows-security 10.125.245.1...

Delete
06/29/202014:30:23 - afewseconds ago Idie = 101252442...
Start Scan

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

Reset Risk Score
Equals

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Download Files to Server.

RSA ‘ Hosts  Files

100 H AGENT SCAN STATUS

windows Start Scan

Export Host details X )
DETAILS PROCESSES LIBRARIES ANOMALIES

Export Files
ALERTS SEVERITY olled over due to retention policies

2 Network Isolation

NT TYPE

_— Download MFT to S :
CRITICAL Saca LI Endpoint

Download System Dump to Server S LA
Blacklisted File (28) S

28 event(s) Download Files to Server

2. In the Download Files to Server dialog, enter the full path where the files may be present or search
using wildcard. For wild card search, you can use a maximum of two *, one at a folder level and the
other at a file level.

For example, to retrieve the registry hive, you can enter the full path,
C:\Windows\System32\config\SYSTEM.

If you want to retrieve user settings and configuration preferences for all users, download all files
using the wildcard C: \Users\ *\NTUSER. DAT.
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Download Files

FILE PATH

C\UsersV\NTUSER DAT|

MUMBER OF FILES FILE SIZE(ME)

3. For wildcard search, enter the number of files to download and size of the file. By default, the
number of files is set to 10 and file size is set to 100 MB. For example, if the maximum number of
files is set to 10 and file size is set to 10 MB, first 10 files within 10 MB are downloaded.

4. Click Download.

All files downloaded as a part of wildcard search are grouped together based on the search criteria. For
example, all files downloaded using C: \Users\*\NTUSER.DAT are grouped, and you can click B o
expand and view all files under this group. You can sort the groups on the downloaded time and view the
status of the download in the Downloaded column.

RSA

\ / windows Idle afew seconds ago 11500
\_/ Windows

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO

Y Filters X Downloads

0O Name DOWNLOADED  SIZE DOWNLOADED TIME SHA256 FILE PATH

> C\Users\"\NTUSER.DAT = v = 8 minutes ago

adayago

v
v - 2daysago
v

Filter Downloaded Files

You can filter the downloaded files on wildcard downloads, file type, file name, SHA256 (for files), and
downloaded time. In the Downloaded Time field, you can also filter by custom date.
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RSA
\__/ windows Idle afew seconds ago 11500

DETAILS PROCESSES AUTORUNS FILES DRIVERS LIBRARIES ANOMALIES DOWNLOADS SYSTEM INFO
Y Filters x  Downloads

O Name DOWNLOADED SIZE DOWNLOADED TIME SHA256 FILE PATH
o v 197.3M8 7 minutes ago NA a
[ > C:\Users\"\NTUSER.DAT 24 minutes ago

0 2 C\sers\ \Desktop\exe\exe\" adayago

v
v

0 > e - v - 2daps3g0
v

0 2 c\sers\y AN®

Equals

Click Save to save the filter and provide a name (up to 250 alphanumeric characters). The filter is added

to the Saved Filters panel on the left. To delete a filter, hover over the filter name and click W

Note: Special characters are not allowed except underscore (_) and hyphen (-) while saving the filter.

Save Downloaded File

You can retrieve the downloaded file and save it to your local file system for further analysis. To save
the file:

1. Go to Hosts.
2. Select the hostname to open the host details and select the Downloads tab.

3. Right-click the file you want to save and select Save a Local Copy from the context menu or from
the toolbar.
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DOWNLOADED  SIZE

Save a Local Copy

Files are ready to download.

If you navigate away from the current host, the download will stop.

| cancer | [iBowRcad

4. In the Save a Local Copy dialog, click Download.

FILE PATH

Note: For wildcard downloads, select a file from the group that are downloaded successfully to save a
local copy. You cannot save multiple files in the group at a time or save files with errors.

Delete Downloaded Files

If you want to delete the downloaded file from the server:
1. Go to Hosts.

2.

Select the hostname to open the host details and select the Downloads tab.

3. Right-click one or more files you want to delete, and select Delete File from the context menu or

from the toolbar.
RSA

AGENT LAST SEEN
afewseconds ago

100

windows Scanning 11500

DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

¥ Filters Downloads | SavealocalCopy || DeleteFile

0O name TYPE DOWNLOADED

MFT

v
Save a Local Copy ' L,
Delete File v

> C:\Users\"\NTUSER DAT

> C:\Users\

DOWNLOADED TIME SHA256 FILE PATH

7 minutes ago NA o

24 minutes ago =

Note: For wildcard downloads, you can select the group to delete all files that are downloaded.
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Analyzing Events

If you need to investigate a particular host, IP address, username, filename, or hash to look for related
activity across a time range, you can pivot to Navigate view to get the entire context of the activity. By
default, the time range is set to 7 days. You can change the time range.

Note: By default, the system detects the best data source to pivot to Navigate view. To change the
data source, modify the investigate service ID under endpoint or investigate in the Explore view.

Analyze Events from Files View

To investigate a particular filename or hash (SHA256 and MD5):
1. Go to Files.

2. Select the file you want to analyze and do one of the following:
¢ Right-click and select Analyze Events from the context menu.

¢ Click Analyze Events in the toolbar.
RSA n espond  Users osts  Files

Y Filters S endpointbrok... View Certificates ‘% Change File Status | | (7 Analyze Events | v || # More Actions -

v FILENAME RISKSCORE  © FIRSTSEENTIME  ONHOSTS REPUTATION size SIGNATURE PERESOURCES... FILE STATUS
Select o) 06/12/202011:16:.. 1 Known 117.1..  unsi = Neutral

- 89.6KB signedyali sare, In Neutral
1LENAME Change File Status
Equals Neutral
Analyze Events

Google Look o ; - Neutral
CIOERED Network Events

VirusTotal Lookup File Events nown o id,...  Micros Neutral

T Process Events ” ali R

Download File to Server Registry Events Neutral

Neutral

Neutral
Reset Risk Score

m}
o
o
o
o
m}
o
o

licrosoft Corpo... Neutral

This opens the Navigate view with data related to the file. For more information on analyzing events
in the Navigate and Events views, see the NetWitness Investigate User Guide.

Note: If the values are not indexed, the results take time to load. For more information, see
Troubleshooting NetWitness Endpoint.

Analyze Events from Hosts View

To investigate a particular host, IP address (IPV4), or username:
1. Go to Hosts.
2. Do one of the following:

o Right-click a host, select Analyze Events from the right-click context menu or in the toolbar, and
select a specific event type (such as network events, file events) that you want to view.
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o Select the hostname to open the host details. Right-click a file or in the toolbar, select Analyze
Events, and select a specific event type that you want to view.

The following figure is an example of the Autoruns tab.

RSA | Users  Hosts  Files D

100 r_/? E AGENT SCAN STATUS AGENT LAST SEEN AGENT VERSION

SNAPSH(C /. :30:
Idle afew seconds ago 11500 SNAPSHOTTIVE w

windows

DETAILS  PROCESSES ~AUTORUNS  FILES DRIVERS LIBRARIES ~ANOMALIES ~DOWNLOADS SYSTEM =

Y Filters x  Autoruns S

FILE NAME W ChangeFileStatus | | (7 Analyze Events

Equals
[  FILENAME LOCALRISK SCO.. GLOBALRISKSC.. ONHOSTS  REPUTATION FILE STATUS DOWNLOADED

FILE STATUS (0) (o) 2 Known Neutral
O Neutral
O Blacklist
O Graylist Analyze Events
O Whitelist

Change File Status ) 2 Known Neutral

Console Events Known Neutral
Google Lookup
Network Events Known Neutral
o VirusTotal Look
REPUTATION rusTotal Lookup — ) -
0 Malicious ) nown kel
» Download File to Server Process Events
0O Suspicious P )
i nown Neutral
O Unknown Registry Events

0 Known Known Neutral

e
Showing 143 out of 143 autoruns | 1 selected

This opens the Navigate view with data related to the file.

For more information on analyzing events in the Navigate and Events views, see the NetWitness
Investigate User Guide.

Text Analysis for an Endpoint Event

You can view all Endpoint events in their original text format in the Events view Event List panel. When
you click an event in the Event list panel, the adjacent panel shows the Text Analysis. Pagination
controls add flexibility when paging through the reconstructed text of an event. The Text Analysis
displays the following:

» Event Header, which provides summary information about the event. (Version 11.5 and Later) The
event header includes host name, process, and user name details in addition to other event details if
the selected Endpoint event contains these metadata.

* Options for exporting - log, csv, xml, and json formats.
* Option to pivot to the Endpoint Thick Client to analyze the meta value.
¢ Option to analyze process details associated with the event.

e Option to view the host details for further analysis.

Below is an example of the Process event for Endpoint. The text in the Text Analysis panel explains that
a source process WmiPrvSE.exe opened a browser process named chrome . exe. In the events, if there
is a meta value that exceeds 255 characters, the value is displayed in the Large Meta Values panel.
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© EPS1-Server - Concentrator V' | | 02/27/2019 07:43am - 03/26/2019 07:42am openbrowserprocess ' x

5,423 Events (Asc) ~ X Endpoint Event Details | Text Analysis
e e s
Download Log [2 Pivot to Endpoint Thick Client [2 Analyze Process [2 Pivot to Host Overview

03/14/201909:4134am  Endpoint 2019-03-14T02:

NW SERVICE SESSION ID NWE CATEGORY COLLECTION TIME EVENT T
EPS1-Server - Concentrator 6965 Process Event 03/14/2019 09:41:34 am 03/14/2019 09:36:26 am
03/14/201909:41:34am  Endpoint 14T09:36:.

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endpoint ® 03/14/2019 09:36:26 an @ @ NT AUTHORITY\NETWORK SERVICE sessionip
TimE
WniPrVSE.exe openBrowserpros chrome. exe e
03/14/201909:4134am  Endpoint FORWARD.IP
1P.ALL
03/14/201909:4134am  Endpoint ; . A MEDIUM
paran. dst=chrom rashpad-handler "--user-data-dir=C:\Users\ \AppData\Local\Google\Chrome\U: DEvICETYPE P
Data” /prefetch: itor-self-annotation-ptype-crashpad-handler "-- DIRPATHSRC I

03/14/201909:4134am  Endpoint . \AppData\Local\Google\Chrome\User Data\Crashpad” "--metrics- DIRPATHALL s
\AppData\Local\Google\Chrome\User Data” --ur! /clients2.google.com/cr/report - DIR.PATH.SRE windowsSystem32
-annotation-plat=Hin64 --annotatio .3683. iti DIRPATHALL windowsSystem32

client-data=ex1e8,0x1ed, 0x1e8,8x1dc, Ox1ec, Bx7 FFa64916830, x7Fa64916840,, 0x7F 264916850 CONTEXT.SRC file-found

03/14/201909:41:34am  Endpoint

CONTEXT.ALL file:found
03/14/201909:41:34am  Endpoint coNTEXT.sRC fle.protected

CONTEXT.ALL fle proteced

3am - 03/26/2019 07:42am  V network event

22,535 Events (Asq) < Endpoint Event Details | Text Analysis m|

Download Log [3 Pivot to Endpoint Thick Client | | [3 Analyze Process | | [3 Pivot to Host Overview

COLLECTION TIME Tvee EVENT TIME

NW SERVICE sEssIoN 1D NWE CATEGORY coLLECTION TiME EVENT TIME
_ EPS1-Server - Concentrator 6768 Network Event 03/14/2019 09:41:34 am 03/14/2019 09:34:15 am
03/14/201909:41:34am  Endpoint :34:. :10003

NETWORK REMOTE ADDRESS

03/14/201909:41:34am  Endpoint

031472019 09:4134am  Endipoinc © 03/14/2019 09:34:15 an @ @ NT AUTHORITY\SYSTEM sessioniD
TIME
03/14/201909:4134am  Endpoint . secureConnector. exe 10.254.20.23 ; size
FORWARD.IP
1P.ALL

03/14/201909:41:34am  Endpoint
MEDIUM

paran. src=SecureConnector.exe -performer -id ADGAB2C2CAS54FBF9AC3109807DC7148 -token pevice.Tve P—

031472019 0%:4134am  Endpoint €22114e7617841b0392af5464293e€4600269dc -ip 10.254.20.237 -port 10003 -sha2s

PORT.DST 10003
34E3B6B148C6FICBDAERBCOBABY1 FA42F7291DBBOFD4@0355880226252628B5D ~1Cif 7 -event PORT.ALL 10003
FSA_TMP_5388_5C89DE73_B@G2PERFORMER_CNTL -rrd @ PORT.DST.ALL 10003
03/14/201909:4134am  Endpoint
DIRPATH.SRC programfiles
DIRPATHALL programfiles
03/14/201909:4134am  Endpoint :34:. CONTEXT.SRC fle.autorun
CONTEXT.ALL file.autorun
CoNTEXT.SRC file.found
03/14/2019 09:41:34am  Endpoint
file.found

fle cratedinlasiMont

For more information on Events view, see the NetWitness Investigate User Guide.
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Isolating Hosts from Network

Note: By default, the network isolation option is disabled in the policy, and you cannot view options
mentioned in this section. To enable network isolation, in the policy configuration, select Enabled in
the Network Isolation option under Response Action Settings. For more information, see the
NetWitness Endpoint Configuration Guide.

To isolate a host from the network:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Isolate from Network from the right-click context
menu, or from the More drop-down list in the toolbar.

RSA n e Hosts  Files

Y Filters 7 Analyze Events J Start Scan

] HOSTNAME RISK SCORE + OS-DESCRIPTION LAST SCAN TIME
NA Microsoft Windows 10 Pro for Workstati... 05/08/202002:2

NA Red Hat Enterprise Linux- 7.2 05/05/2020 05:5]

anaged NA Red Hat Enterprise Linux-7.2 05/06/2020 07:3
O Roaming

O Isolated

— 05/06/2020 07:4
Analyze Events
05/05/2020 010
Delete

Start Scan 05/06/2020 07:2¢

Network Isolation 2 | Isolate from Network
HOSTNAME Download MFT fo Server

Equals .
Download System Dump to Server (C sl

USERNAME Download Files to Server 05/06/2020 07:3

Equals Reset Risk Score

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Isolate from Network.

RSA

100 AGENT SCAN STATUS AGENT LAST SEEN AGENT VERS

o - few seconds ago 11.5.00
WIIERE Start Scan

Export Host details
DETAILS PROCESSES LIBRARIES ANOMALIES

Export Files
ALERTS SEVERITY rolled over due to retention policies

2 Network Isolation Isolate from Network

CRITICAL Download MFT to Server

Download System Dump to Server
Blacklisted File (28)

I e ) Download Files to Server
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2. In the Isolate from Network dialog, by default, a set of IP addresses are excluded from isolation. For
more information, see Network Isolation. To add IP addresses to the list, select the Add your IPs to
Exclusion List checkbox. You can enter up to 100 IP addresses separated by comma.

|solate from Network

Network Isolation blocks the host from connecting to the networl.
All attempted network connections are monitored and reported to the
Endpoint Server.

Add IP add

3. Enter comments.

4. Click Isolate Host.

Edit Exclusion List

To edit the exclusion list:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Edit Exclusion List from the right-click context
menu, or from the More drop-down list in the toolbar.
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RSA Investi d J Hosts Files BE ds R
Y Filters X [ Analyze Events J Start Scan

HOSTNAME RISK SCORE <  OS- DESCRIPTION LAST SCAN TIME

NA Microsoft Windows 10 Pro for Workstati.. 05/08/202002:21:}

O
O
O NA Red Hat Enterprise Linux- 7.2 05/05/2020 05591
O

NA Red Hat Enterprise Linux- 7.2 05/06/202007:384
O Roaming —

3 =
o 05/06/2020 07:47}
Isolated Analyze Events

5, 207
Delete 05/05/2020 01-07

Start Scan - 05/06/2020 07:207]

Network Isolation > | Release from Isolation

Edit Exdusion List
Download MFT to Server

Equals
- Download System Dump to Server 05/07/202008:44;

USERNAME Download Files to Server 05/06/202007:32

Equals Ent: ue Reset Risk Score

Microsoft Windows 7 Enterprise 05/08/2020 06:53]

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Edit Exclusion List.

RSA r = J Hosts Files

AGENT SCAN STATUS AGENT LAST SEEN AGENT VE

‘ew seconds ago 11.5.00

100

windows

Start Scan

~ Export Host details
DETAILS PROCESSES AUTO BRARIES ANOMALIES

Export Files
ALERTS SEVERITY bd over due to retention policies g

1 Network Isolation Release from Isolation

CRITICAL Download MFT to Server Edit Exclusion List

Download System Dump to Server —

Blacklisted File (21)

91 event(s) Download Files to Server

2. Add or modify the IP addresses in the list.

3. Enter comments and click Save.

Release Isolated Hosts

Releasing the isolated host restores the network connection and removes IP addresses added to the
Exclusion list. To release the host from isolation:

1. Go to Hosts and do one of the following:

o Select a host and select Network Isolation > Release from Isolation from the right-click context
menu, or from the More drop-down list in the toolbar.
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RSA

Y Filters

Hosts Files

=] endpointbrok...

HOSTNAME

[ Analyze Events . ) Start Scan

RISK SCORE + OS-DESCRIPTION

NA Microsoft Windows 10 Pro for Workstati...
N/A Red Hat Enterprise Linux-7.2

N/A Red Hat Enterprise Linux- 7.2

indows 8.1 Enterprise

Analyze Events

Delete 04.4LTS

Start Scan erprise Linux 8.1 (Ootpa)

indows 10 Education

Network Isolation Release from Isolation

Edit Exclusion List
Download MFT to Server

Download System Dump to Server 04.6LTS

Download Files to Server ux 8 (Core)

Reset Risk Score

indows 10 Education

Microsoft Windows 7 Enterprise

* Select the hostname to open the host details, click E (More) beside the hostname, and select
Network Isolation > Release from Isolation.

RSA

100 =

windows

DETAILS PROCESSES AUTO

ALERTS SEVERITY

1

CRITICAL

Blacklisted File (91)

21 event(s)

Start Scan
Export Host details

Export Files

Network Isolation

Download MFT to Server

Download System Dump to Server

Download Files to Server

2. Enter comments and click Release Host.

BERARIES

ANOMALIES
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NetWitness Endpoint with Third-Party Antivirus

Products

If you want the NetWitness Endpoint agent to coexist with any of the security products, make sure to
whitelist the agent. For more information, see the respective third-party product documentation.
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This section provides information about possible issues when using NetWitness Endpoint.

General Issues

Some of the hosts or files data are not displayed when Endpoint Broker is selected for
querying.

The Endpoint Broker aggregates data from all Endpoint Servers, which responds within
10 seconds. You must increase the query timeout value to see the result of Endpoint
server that is online. Perform the following:

Q
1. Goto (Admin) > Endpoint Broker service.
2. Click & > View > Explore.

3. Click endpoint/broker node.

4. In the query-timeout field increase the value, for example, 30 seconds.

The Endpoint Agent is unable to communicate with the Endpoint Server. The connection
may not be established due to any of the following issues:

 UDP
e HTTPS

e Firewall

e To verify the UDP or HTTPS connection, you must verify the connection between
Windows Endpoint Agent and Endpoint Server:

1. Go to System32 folder using the following command:
cd C:\Windows\System32

2. Execute the following command:

<Agent Service name>.exe /testnet
For example, NWEAgent .exe /testnet

 If the issue is with the firewall, check the incoming and outgoing firewall rules.

The Endpoint Agent is unable to communicate with the Log Decoder. The connection
may not be established due to any of the following issues:

 UDP
 TCP
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e TLS

¢ Firewall

e To verify the UDP, TCP, and TLS connection, you must verify the connection between
Windows Endpoint Agent and the Log Decoder:

1. Go to System32 folder using the following command:
cd C:\Windows\System32

2. Execute the following command:

<Agent Service name>.exe /testlognet
For example, NWEAgent .exe /testlognet

¢ If the issue is with the firewall, check the incoming and outgoing firewall rules.

Multi-server Issue

Agent is not communicating with the Endpoint Server after migration.

Check the Nginx logs of the Endpoint Server to which the agent has migrated, and if the
agent is communicating with error code 403, that means the certificate of the first
Endpoint Server and second Endpoint Server are different. This is because during the
installation of second Endpoint Server, the certificate of first Endpoint Server is not
copied to the second Endpoint Server.

Reinstall the second Endpoint Server by copying the certificate of first Endpoint Server,
and reinstall the agent. For more information, see the Physical Host Installation Guide.

Hosts View Issues

An error has occurred. The Endpoint Server may be offline or
inaccessible.

When attempting to access the Hosts or Files view, the view opens with the message.

Endpoint Server or Nginx Server is not running. Check the status of the Endpoint

Server under (Admin) > Services or check if the Endpoint Server host IP
address is registered with the Admin Server. For more information, see the Physical
Host Installation Guide or Virtual Host Installation Guide. If the service is not
running, start the Endpoint Server.

For MFT download:

1. The request fails with file not found error for drives/mount paths created on
the machine after agent is installed.

2. Incorrect MFT is downloaded for the provided NTFS mount path.
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Make sure that the agent version is 11.6 or later.

Files View Issues

Unable to analyze events from Hosts and Files view.

Other than Broker or Concentrator, if any aggregation service, such as Archiver, is
aggregating data from the Log Decoder that is configured for metadata forwarding
from any Endpoint server, clicking Analyze Events from Hosts and Files view for
this Endpoint server may not work. To resolve this issue:

Note: To get the investigate-service-id:
1) Go to K& (Admin) > Services > Concentrator service.

2) Click & > View > Explore tab.
3) Expand the sys/stats node list.
4) In the UUID filed, copy the value.

4
1. Goto (Admin) > Services > Endpoint Server service.

2. Click £ > View > Explore tab.

3. In the endpoint/investigate ficld, specify the investigate-service-id.

Policy Issue

Policy status in the Policy Details panel is not updated or shows Policy
Unavailable/Permission Required.

Policy Unavailable - Hosts belong to previous versions, such as NetWitness Platform
11.1 or 11.2, where a policy is not applied.

Permission Required - If you do not have permissions, see the "Role Permissions"
topic in the System Security and User Management Guide.

Policy Status shows error.

Policy may have wrong configurations. Check the error description, logs in Endpoint
server, and audit logs for details. Contact your system administrator with the error
details.
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Driver Issue

While loading the driver on the host, an error is encountered.

Check the driver error code in the Agent-Driver Error Code column under Hosts
view. Contact your system administrator with the error code.

File Reputation Service Issue

When you configure RSA Live for the first time and the File Reputation service is not
connected.

You must manually enable the File Reputation service. To enable the File Reputation
service:

A
1. Goto (Admin) > System > Live Services.
2. In the Additional Live Services section, select the enable File Reputation check box.

3. Click Apply.

Risk Scoring for Hosts or Files Issue

NetWitness Endpoint takes a long time to process risk scoring for Hosts or Files.

Check the backlog of alerts for risk scoring.
1. SSH to the ESA Primary appliance.

2. Execute the following command:

mongo respond-server --authenticationDatabase admin -u deploy
admin -p <deploy admin password> --eval 'db.staging.find({"Sor":
[{state:"STAGED"}, {state :"WORKING"}]1}).count()' --quiet

The backlog count is displayed. If the backlog count is 1 million or greater, you must
disable the risk scoring and Endpoint ESA alerts.

3. To disable risk scoring:

Q
a. Goto (Admin) > Services > Respond service.

b. Click 2 > View > Explore.
c. Expand the respond/scheduled/jobs node list.
d. In the risk-scoring-enabled field, set the value to false.
4. To disable Endpoint ESA alerts:
a. To disable NetWitness Endpoint ESA alerts generation for severity; Critical, High
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and Medium.

i. Goto (Configure) > ESA Rules.
The Configure view is displayed with the Rules tab open.

ii. In the Options panel, under Deployments, select the Endpoint deployment to
delete.
A confirmation dialog is displayed.

iii. Click Yes.
b. To disable only Medium severity NetWitness Endpoint ESA alerts:

1. Go to K&l (Admin) > ESA Correlation service (on which Endpoint
deployment is added).

i, Click ® > View > Explore.
iii. Expand the correction/alert node list.

iv. In the transient-enabled ficld, set the value to false.
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This section is intended to help you understand the purpose and application of NetWitness Investigate >
Hosts view and Files view. For each view, there is a brief introduction and a What Do You Want To Do
table with links to related procedures. In addition some of the reference materials include workflows and

Quick Looks to highlight important features in the user interface.

e Files View
e Hosts View

e Hosts View - Details Tab

e Hosts View - Process Tab

e Hosts View - Autoruns Tab

e Hosts View - Files Tab

e Hosts View - Drivers Tab

e Hosts View - Libraries Tab

e Hosts View - Anomalies Tab

e Hosts View - Downloads Tab

e Hosts View - System Information Tab

e Hosts View - Agent History Tab
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Files View

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Files view provides a holistic view of all files in your deployment. To access this view, go to Files.
By default, the Files view displays 100 files. To display more files, click Load More at the bottom of
the page.

You can either view files specific to an Endpoint server or view all files from multiple Endpoint servers
by selecting the Endpoint Broker.

Workflow

Analyze Events

(Navigate or Event
Analysis View)

Whitelist Files/ Create Fikier &
reate Filter to
Certificates Signed by Identify Files Anal Fil > Download Files for
entify Files for nalyze Files
Known Good y_ ) Y Deeper Analysis
Investigation
Vendors

Perform External

—

—

Lookups

What do you want to do?

User
Role

Threat whitelist files and certificates signed by known good  Analyze Certificates

Hunter vendors*®

Threat create filter to identify files for investigation* Filter Files

Hunter -

Threat analyze files* Investigating Files

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for
Hunter a File

Threat change file status or remediate* Changing File Status or
Hunter Remediate

*You can perform this task in the current view
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Related Topics

e Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Analyzing Events

e Analyze Certificates

e Changing File Status or Remediate

Quick Look

Below is an example of the Files view:

RSA g d U Files ard  Reports

Y Filters S endpointbrok... View Certificates “# Change File Status Z Analyze Events . # More Actions v

O Fename

3]

4 FIRSTSEENTIME ON HoOsTS. RePUTATION

06/23/202008:36:49am 2 =

06/23/202008:36:49am 2

07/06/202007:10:55

07/06/202007:1¢

07/06/202007:10:58.

07/06/202007:10:55

07/06/202007:10:58 3m

07/08/202012:50:26 pm

07/06/202007:10:58 3m

07/07202005:52:223m

07/07/202005:52:22.

07/08/202007-10:58

07/06/202007:10:55

07/06/202007:10:55

07/06/202007:10:58 3m 36: microsoft signedy

07/06/202007:10:58 am microsoftsignedy

07/06/202007:10:58 3m

07/06/202007:10:55

07/06/202007:10:55 1055K8

07/06/202007:1¢ 155K8  microsoftsignedy

4“ o | |F1LE DETAILS

nlaapi.dil

e nlaapidil

6426718559932449

85KB

e [

= microsoft,signedyalidcatalog

P 06/06/20200: .356am

24341b9fd50b9964283220a36...

zner Microsoft Windows

D3 fb7ddd5b0f0da76c4ed1943233...
1 0e472395e6999e0b22116c298...

56 b487a51F296c9feead619eb4223...

Filter Files. You can filter the files by selecting the options in the Filters panel and create
filters. For more information, see Filter Files.
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Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view
the hosts.

View Certificates - Provides a list of code-signing certificates reported by hosts found in your
deployment and their associated properties. For more information, see Analyze Certificates.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected files to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
* Download files to server, save a local copy, and analyze files for deeper analysis.

¢ Reset risk score.

Note: You can perform the above actions from the right-click context menu.

Sort Columns. Lets you sort on column titles.

Settings Menu. You can set Files view preferences by selecting columns from the Settings
menu. For more information, see Set Files Preference.

Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.
Risk details - Displays the distinct alerts associated with the risk score.

Hosts - Displays the top 100 hosts based on the risk score on which the file is present. For
more information, see Analyze Hosts with File Activity.

Export to CSV - Extracts global files to a CSV file. For more information, see Export Global
Files.

File Details View

To access this view, go to Files, and select a file. Below is an example of the File Details view:
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signedvalid ~ 14MB  Blacklisted

ALERTS SEVERITY © Events rolled over due to retention policies or manual deletion will not be available.
4 events

VENT TIM
CRITICAL ALL 11/18/2019 10:45:41.000 am

d File (4)
OneDriveexe
4283913667539894
11/18/2019 1045:41000am - NA Eps Ao indovs eOni 14MB

pe

VEN signedyalid
11/18/2019 10:36:10.000am 01/12/2019 12-33:-39.626 am
23710f52824b1c3616496d4a3d...

Microsoft Corporation

1 U‘1W2019 10:36:10.000 am
9edb70213f7015292e37428272..

fb3401a77f045db132d9681b8...
44bd2686cd0f31edf3da1616a9.

Agent and Scan Details. You can view the following agent and scan details of the selected host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to perform external lookups.

On Hosts - Indicates the number of hosts on which a file exist.
Signature - Provides signatory information.

Size - Size of the file.

File Status - Status of the file. For example, Neutral.
PN Details tab - Displays list of distinct alerts, such as Critical, High, Medium and All, along with
the total number of events associated with the alert.

Analysis tab - Provides detailed information about a downloaded file. For more information, see
Analyzing Downloaded Files.

Displays events for an alert and metadata associated with a specific event.

%88 Show/Hide File Properties Panel. Click a row to show or hide the File Properties panel. It
displays the following tabs:

File Details - Displays the file information.

Hosts - Displays the hosts on which file activities are present. For more information, see Analyze
Hosts with File Activity.
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Hosts View

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Hosts view provides a list of all hosts with an Endpoint agent installed. To access this view, go to
Hosts. By default, hosts are sorted based on the risk score.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Secan
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies* Analyze Anomalies
Hunter
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N TN

Threat analyze risky users* Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump*  or process Performing Host Forensics
Hunter dump

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Investigating a Process

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Hosts view:
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RSA  inesie Users  Hosts  File

Y Filters © endpointloghy... & Analyze Events | v || @StartScan 3 More Actions ~/ & D Windows10

HOST DETAILS
O wosTnamEe RISKSCORE & OS- DESCRIPTION LAST scAN TIME usERNAME AGENT LAST SEEN AGENT SCANSTA |G

100 Microsoft Windows 10 Enterprise  06/24/202021:30:33. WINDOWS10\ecat, .~ afewsecondsago Idie

»s Windows-security

2

ps Administrators

Intel(R) 82574L Gigabit Network..

2y 10.125244.1
10.31.64.22,10.31.64.23
= fabse
@) custompare
Microsoft Windows 10 Enterprise

er 18362

Filter Hosts,You can filter the hosts by selecting the options in the Filters panel and create
filters. For more information, see Filter Hosts.

Actions in the toolbar:

Server drop-down list - You can select the Endpoint server or Endpoint Broker server to view
the hosts.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

Start Scan - Starts a scan for the selected hosts.
Stop Scan - Stops a scan for the selected hosts.
More Actions - Provides options to:

¢ Reset risk score.

e Delete - Lets you delete hosts manually from the user interface. After deletion, the Endpoint
server does not process any request from this host. For more information, see Delete a Host.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

* Download System Dump to the server. For more information, see System and Process
Memory Dump.

e Isolation host from the network. For more information, see Isolating Hosts from Network.

Note: You can perform the above actions from the right-click context menu.

KB Sort Columns. Lets you sort on column titles.

4 Export to CSV - Extracts host attributes to a CSV file. For more information, see Export Host
Attributes.
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R Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

(I Show/Hide Host Properties Panel. Click a row to show or hide the Host Properties panel. It
displays the following tabs:

Host details - Displays the host information such as Network Interfaces, operating system,
hardware and others.

Risk details - Displays the distinct alerts associated with the risk score.

A View Agent History - Displays the list of commands issued to the agent. For more
information, see View Agent History.
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Hosts View - Details Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Details tab provides details of the selected host. To access this view, go to Hosts view, and select a
host.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Sean
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Change File Status Remediate

- Search on Snapshot

- Analyze Processes Perform External

Lookups

- Review Reported Anomalies
(for Windows)

[Optional) Isolate

- Analyze Risky Users (Users View) Host from Network

What do you want to do?

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details* Analyze Host Details
Hunter

Threat search files on host* Search Files on Host
Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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N TN

Threat analyze risky users* Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis Analyzing Downloaded Files
Hunter

Threat perform external lookups Launch an External Lookup for a
Hunter File

Threat change file status or remediate Changing File Status or Remediate
Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT*, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

* Investigating Hosts

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Details tab:

01/02/202002:32:50 pm

Lie A ES  DOWNLOADS  SYSTEM INFO HISTORY

olled over due to retention policies or manual deletion will not be available.

01/03/202007:13:12000am  Endpoint  ProcessEvent  createProcess  Win101511x64  WIN101511X6d\ecat  windows

C\Windows\System32\ 2
C\Windows\system32\
N Administrators,Remote, Desktop,

Agent and Scan Details. You can view the following agent and scan details of the selected host:
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Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.
Operating System - Operating system on which the agent is running (Linux, Windows, or Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping Scan.
For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or hash
to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

¢ Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Search files on host. Lets you search the files on the host iﬁle name, file path, and SHA-256
checksum). For more information, see .

Show/Hide Right Panel - Displays host and policy details panel.

Host Details Panel - Displays all properties of the selected host. It is grouped as follows:
Groups - Groups on which the host is added on.

User - Information related to the user.

Network Interfaces - Network adapter information, such as Mac Address, Gateway.
Operating System - Operating system version and build information.

Agent - Agent-related information, such as agent ID, driver error code, install time, and agent
mode.

Hardware - Information related to the architecture.

Locale - Time zone and language that is local to the host.
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LB Policy Details Panel - Displays the following:
e Policy Status -
e Updated - Host has the latest policy.

¢ Pending - Policy is resolved but the latest policy is not updated on the host. When the
host communicates with the Endpoint server next time, the latest policy is applied if there
are no errors.

¢ Unavailable - Hosts that belong to previous versions, such as NetWitness Platform 11.1 or
11.2, or the source server is not installed.

e Error - Problem applying the latest policy along with the error description.
¢ Blocked Hashes Status -
e Updated - Host has the latest blocked hashes.

¢ Pending - Hashes are blocked but the latest hashes are not updated on the host. When the
host communicates with the Endpoint server next time, the latest hashes are applied if
there are no errors.

¢ Evaluated Time - Time when the Endpoint server evaluated the policy.
e Relay Server. Displays the Relay Server details.

© Server - Host name or IP address of the Relay Server.

° Port - Port number.

°© HTTP Beacon Interval - HTTP beacon interval value in minutes.

e Complete resolved policy settings. For more information, see "Managing Policies" in the
NetWitness Endpoint Configuration Guide.

Note: The values that are not set in the policy are not displayed.

Alerts Severity - Displays list of distinct alerts, such as Critical, High, Medium and All, along
with the total number of events associated with the alert.

gB Displays events for an alert and metadata associated with a specific event. For more
information, see Analyze Hosts Using the Risk Score.
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Hosts View - Process Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Process panel provides a list of processes running on the host. To access this tab, select a host from
the Hosts view and click the Process tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Secan
Deeper Analysis

- Review Host Details, such as

Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host
Forensics

Remediate

Change File Status

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

[Optional) Isolate
Host from Network

- Analyze Risky Users (Users View)

What do you want to do?

T T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot™* Search Files on Host
Hunter

Threat analyze processes* Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat i1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Investigating a Process

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Process tab:
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01/02/202002:3250pm

orssee
4288265716902283
75KB

pe

microsoftsignedyalid catalog
07/14/2009 03:17-39.000 am

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.

Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

Start a scan for the selected hosts. For more information, see Scan Hosts.

Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

Isolation host from the network. For more information, see Isolating Hosts from Network.

Download MFT to the server. For more information, see Performing Host Forensics.

Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you select the snapshot
time from the drop-down menu.
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Actions in the toolbar:

Analyze Process - Lets you perform process analysis to investigate a particular process
behavior, and understand the entire process event chain, process parent-child relationships, and
all associated events. For more information, see Investigating a Process.

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.
¢ Download files to server, save a local copy, and analyze files for deeper analysis.

e Download process dump to server.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots, Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

"Bl Toggle. Lets you toggle between List view and Tree view.

Process panel - Displays process information, such as process name, local risk score, global
risk score, On Hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties of a process in the right panel:
 File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.
Hash - Hash type of the file (MD5, SHA1, and SHA256).
Time - Time when the file was created, modified, or accessed.
Location - Location of the file.
Process - Details of the process, such as image size and PID.

Image - Image details loaded by the process.

e Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and Al

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

gl Filter Files, You can filter processes by selecting the options in the Filters panel and create
filters. For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference,
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Process Details
Clicking the process name displays the process details of a specific process as shown in the following

figure:

R SA Irve 2 nd U Hosts Files

: AGENT LAST SEEN A ON

00 * SN HoT TIME  06/24/2020 21:30:33
c windows afew seconds ago L

SYSTEM INFO HISTORY

DETAILS PROCESSES AUTORUNS L = DRIVERS LIBRARIES ANOMALIES DOWNLOADS

< Processes | Process Details

PATH

C:\Windows\System32\

N

Process Name Name of the process. For example, server.exe,

PID ID of the process. For example, 492.

Path Path of the file associated with the process on the disk. For example,
C:\Windows\System32.

Launch Command line arguments passed to the process when it is launched. For example, -k

Arguments LocalServiceNoNetwork.

e List of loaded libraries for the selected process, such as DLLs (for Windows), Dylibs (for Mac), or
.SO (for Linux).
e List of autoruns (if configured).

e List of image hooks and suspicious threads (for Windows).
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Hosts View - Autoruns Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Autoruns panel provides a list of autoruns, services, tasks, and cron jobs running on the host. To
access this tab, select a host from the Hosts view and click the Autoruns tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host
Forensics

Remediate

Highest Risk Score Change File Status

-Search on Snapshot
- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?

T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis™ Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files Filter Host Details

Hunter

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

e Focusing on Endpoint Analysis

e Investigating Hosts

e Analyzing Downloaded Files

e Changing File Status or Remediate

e Analyzing Events

e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Autoruns tab:

ME  06/24/202021:30:33

V Filters x ||Autoruns

Equals
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B Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

b Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

¢ Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

RIl Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.
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VBl Details Panel - Displays the following tabs:

e Autoruns - Files that are executed at start-up.

* Services - Files that are running as a service for the selected host.

e Tasks/Cron jobs - Files that are configured to run as scheduled tasks along with the trigger.
S Show/Hide Right Panel - Displays the following properties in the right panel:

» File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Autoruns/Services/Tasks - Details related to autrouns, services, or tasks.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and AlL

e Hosts -Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

121 NetWitness Endpoint Reference Materials



NetWitness Endpoint User Guide

Hosts View - Files Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Files tab displays all files on the host including the files deleted within last 30 days. To access this
tab, select a host from the Hosts view and click the Files tab. By default, it displays 100 files. To display
more files, click Load More at the bottom of the page.

Workflow

Analyze Events
(Navigate or Events [y
View)

Analyze Hosts

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host
Forensics

Change File Status Remediate

Highest Risk Score

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate

- Analyze Risky Users {Users View) Host from Network

What do you want to do?

N TR

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search files on host* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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N TN

Threat analyze risky users

Hunter

Threat analyze events*

Hunter

Threat download files for deeper analysis™*
Hunter

Threat perform external lookups*

Hunter

Threat change file status or remediate*
Hunter

Threat filter files™

Hunter

Threat isolate host from network™

Hunter

Threat download MFT*, system dump, or process
Hunter dump*

*You can perform this task in the current view.

Related Topics

Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Downloaded Files

Changing File Status or Remediate

Analyzing Events

Performing Host Forensics

Isolating Hosts from Network

Quick Look

Below is an example of the Files tab:

01/02/202002:32:50pm

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Filter Host Details

Isolating Hosts from Network

Performing Host Forensics

ondee
61411942119893155
2285K8
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5

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.

¢ Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search files on host. Lets you search the files on the host (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

All Files Available on Host - Lists all files (reported as part of scan and tracking) on the host.
By default, All Files Available on Host toggle is enabled for Windows and Mac.

Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, package details and others.
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(M Show/Hide Right Panel - Displays the following properties in the right panel:
« File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

* Hosts - Displays the top 100 hosts based on the risk score on which the file is present.

g Clicking a filename lets you navigate to the Files view for further analysis.

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.

Note: In the Deleted column, a trash icon appears next to the deleted file. The Deleted
column is not displayed if you disable All Files Available On Host.

For more information, see Filter Host Details.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Drivers Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Drivers tab lists the drivers running on the hosts at the time of scan. To access this tab, select a host
from the Hosts view and click the Drivers tab.

Workflow

Review Hosts with

Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoe Secan
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files
-Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users {Users View)

What do you want to do?

N TR

review hosts with highest risk score*

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

Threat
Hunter

analyze hosts*

perform adhoc scan*

review host details

search on snapshot™*

analyze processes

review reported anomalies

Analyze Events
(Navigate or Events [y
View)

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

Change File Status Remediate

(Optional) Isolate
Host from Network

Analyze Hosts Using the Risk Score

Investigating Hosts

Scan Hosts

Analyze Host Details

Search Files on Host

Investigating a Process

Analyze Anomalies
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N TN

Threat analyze risky users

Hunter

Threat analyze events*

Hunter

Threat download files for deeper analysis™*
Hunter

Threat perform external lookups*

Hunter

Threat change file status or remediate*
Hunter

Threat filter files™

Hunter

Threat isolate host from network™

Hunter

Threat download MFT*, system dump, or process
Hunter dump*

*You can perform this task in the current view.

Related Topics

Focusing on Endpoint Analysis

Investigating Hosts

Analyzing Downloaded Files

Changing File Status or Remediate

Analyzing Events

Performing Host Forensics

Isolating Hosts from Network

Quick Look

Below is an example of the Drivers tab:

01/02/202002:3250 pm

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded Files

Launch an External Lookup for a
File

Changing File Status or Remediate

Filter Host Details

Isolating Hosts from Network

Performing Host Forensics

NWEDriver2303sys
6.423240674371836
2430K8

pe

127

NetWitness Endpoint Reference Materials



NetWitness Endpoint User Guide

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

¢ Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, IP address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.

e Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

Details Panel - Displays information, such as filename, local risk score, global risk score, on
hosts, reputation status, file status, and others.
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S Show/Hide Right Panel - Displays the following properties in the right panel:
« File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Image - Loaded image.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

* Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details.

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.
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Hosts View - Libraries Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The Libraries tab lists the libraries loaded at the time of scan. To access this tab, select a host from the
Hosts view and click the Libraries tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )
Deeper Analysis

- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files

Perform Host
Forensics

Remediate

Highest Risk Score Change File Status

-Search on Snapshot
- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)

What do you want to do?

T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files* Filter Host Details

Hunter

Threat 1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

¢ Investigating Hosts

¢ Analyzing Downloaded Files

¢ Changing File Status or Remediate

¢ Analyzing Events

¢ Performing Host Forensics

¢ Isolating Hosts from Network

Quick Look

Below is an example of the Libraries tab:
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RSA
{2

AGENT LAST SEE 1
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windows
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DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES ~ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY 2

Y Filters X | Libraries || ® ChangeFileStatus || 7 AnalyzeEvents i More Actions v

PROCESS CONTEXT FLENAME LOCAL RISK SCORE. GLOBAL RISK SCORE ONHOSTS  REPUTATION FILEsTATUS DOWNLOADED

FILE DETAILS

vmtoolsdexe: 5855 Blacklisted
Blacklisted
Blacklisted
Blacklisted
Blacklisted
Blacklisted FileName  sige-2.0ll
Neutral Entropy  4.496548278504887
= 765KB
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e
svchost exe: 4532 Neutral
ed false

svchost exe: 4532 Neutral

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.

Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

e Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More Actions - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

* Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays information, such as process context, filename, local risk score, global
risk score, on hosts, reputation status, file status, and others.

Show/Hide Right Panel - Displays the following properties in the right panel:

 File Details - Displays all properties of the selected process. It is grouped as follows:
General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Process - Details of the process, such as image size and PID.

Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,

Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference,

L]
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Hosts View - Anomalies Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.3 and later.

The Anomalies panel provides a list of image hooks, suspicious threads, kernel hooks, and registry
discrepancies running on the host. To access this tab, select a host from the Hosts view and click the
Anomalies tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events [y
View)

- Review Risk Contributors

Download Files for

- Perform Adhoe Secan )

Deeper Analysis
- Review Host Details, such as
Autorun, System Information,

Review Hosts with Libraries, Processes, Drivers, Files Perform Host

Forensics

Highest Risk Score Change File Status Remediate

-Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate

- Analyze Risky Users {Users View) Host from Network

What do you want to do?

T

Threat review hosts with highest risk score* Analyze Hosts Using the Risk Score
Hunter

Threat analyze hosts* Investigating Hosts
Hunter

Threat perform adhoc scan* Scan Hosts

Hunter

Threat review host details Analyze Host Details
Hunter

Threat search on snapshot* Search Files on Host
Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies* Analyze Anomalies
Hunter
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T T T

Threat analyze risky users Analyzing Risky Users

Hunter

Threat analyze events* Analyzing Events

Hunter

Threat download files for deeper analysis* Analyzing Downloaded Files
Hunter

Threat perform external lookups* Launch an External Lookup for a
Hunter File

Threat change file status or remediate* Changing File Status or Remediate
Hunter

Threat filter files Filter Host Details

Hunter

Threat 1solate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, system dump, or process Performing Host Forensics
Hunter dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

¢ Investigating Hosts

¢ Analyzing Downloaded Files

¢ Changing File Status or Remediate

¢ Analyzing Events

¢ Performing Host Forensics

¢ Isolating Hosts from Network

Quick Look

Below is an example of the Anomalies tab:
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By

NWEDriver2303sys
6423240674371836
2430KB

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.

More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.
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Actions in the toolbar:

Change File Status - Provides capabilities to manage suspect and legitimate files and block
malicious or infected file to prevent future execution of the file on any host. For more
information, see Changing File Status or Remediate.

Analyze Events - Lets you investigate a particular host, [P address, username, filename, or
hash to get the entire context of the activity. For more information, see Analyzing Events.

More - Provides options to:
e Perform external lookups.
¢ Download process dump to server.

* Download files to server, save a local copy, and analyze files for deeper analysis.

Note: You can perform some of the above actions from the right-click context menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host.

Details Panel - Displays the following tabs:

* Image Hooks
e Kernel Hooks

e Suspicious Threads

e Registry Discrepancies

Show/Hide Right Panel - Displays the following properties in the right panel:
 File Details - Displays all properties of the selected process. It is grouped as follows:

General - General information about the file, such as file name, entropy, size, and format.
Signature - Provides signatory information.

Hash - Hash type of the file (MD5, SHA1, and SHA256).

Time - Time when the file was created, modified, or accessed.

Location - Location of the file.

Image Hooks/Kernel Hooks/Suspicious Threads/Registry Discrepancies - Details related
to image hooks, kernel hooks, suspicious threads, or registry discrepancies.

* Local Risk Details - Displays the alerts associated with the local risk score, such as Critical,
High, Medium and All.

e Hosts - Displays the top 100 hosts based on the risk score on which the file is present.
Clicking a filename lets you navigate to the Files view for further analysis.

g Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter Host Details,
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Settings Menu. You can set Hosts view preferences by selecting columns from the Settings
menu. For more information, see Set Hosts Preference.

Image Hooks

Image hooks found in executable image are displayed in the following columns.

Type

Local Risk
Score

Global Risk
Score

Reputation

Signature

Downloaded

Hooked
Process

Hooked
Filename

Hooked
Symbol

Kernel Hooks

Type of the hook . Possible values are - inline, iat, eat, or exception Handler.

Risk score of suspicious or malicious activities performed by the file on a specific
host.

Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.

Provides signatory information.

Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Process in which hooks are placed.

Name of the file that was modified by the hook.

Symbol in which the hook is performed.

Hooks found on kernel objects are displayed in the following columns.

Type

Driver name

Local Risk
Score

Global Risk
Score

Type of kernel object which was modified. Possible values are:
objectlnitializer,basicObjectPointer, majorFunction, invalidObject, fastlO,
notifyRoutine, attachedDevice, device, miniPort, sdt, sysEnter, or type.idt.

Name of the driver which placed the hooks.

Risk score of suspicious or malicious activities performed by the file on a specific
host.

Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.
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Reputation Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown, Known,
Known Good, and Invalid.

Signature Provides signatory information.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Object Name of the object function hooked into.
Function

Hooked File ~ Name of the file that was modified by the hook.
Name

Suspicious Threads

Threads whose service table was hooked are displayed in the following columns.

Start Address Start Address - Start address of the thread.
DLL Name Name of the DLL.

Local Risk Score  Risk score of suspicious or malicious activities performed by the file on a specific
host.

Global Risk Score  Aggregated score of all suspicious and malicious activities performed by the file
across all hosts.

Reputation Reputation of a file hash. The statuses are - Malicious, Suspicious, Unknown,
Known, Known Good, and Invalid.

Process File name and PID of the process in which thread is running.

Downloaded Indicates the status of the downloaded file - Downloaded, Not Downloaded, and
Error.

Signature Provides signatory information.

Thread ID ID of the running thread.

Thread Address of the thread environment block.

Environment

Block

Registry Discrepancies

Configuration settings and options on Microsoft Windows operating systems that are stored are displayed
in the following columns.
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Hive Name of the registry hive when possible, otherwise it displays the hive ID. Possible
values are: hkeyClassesRoot, hkeyCurrentUser, hkeyLocalMachine,
hkeyUsers, or hkeyPerformanceData,

Reason Type of registry discrepancy. Possible values are: notFound, embeddedNull,
accessDenied, parentlsHidden, or dataMismatch.

Registry Path Registry path that is affected. The value is separated by a @ character.
Raw Type Value type found in the low-level parsing.

Raw Data Value data extracted from the low-level parsing.

API Type Value type from the Win32 registry APIL.

API Data Value data from the Win32 registry APIL.

Hosts View - Downloads Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.4 and later.

The Downloads tab provides information about all downloads (MFT, files, system dump, and process
dump) performed on the host. To access this tab, select a host from the Hosts view and click the
Downloads tab.

Workflow

Analyze Events
Analyze Hosts (Navigate or Events L
View)

- Review Risk Contributors

Download Files for

- Perform Adhoc Scan )
Deeper Analysis
- Review Host Details, such as
Autorun, System Information,
Review Hosts with Libraries, Processes, Drivers, Files
Highest Risk Score

Perform Host

3 Change File Status Remediate
Forensics

- Search on Snapshot

- Analyze Processes Perform External

Lookups
- Review Reported Anomalies

(for Windows)

(Optional) Isolate
Host from Network

- Analyze Risky Users {Users View)
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What do you want to do?

User

Role

Threat review hosts with highest risk score Analyze Hosts Using the Risk
Hunter Score

Threat analyze hosts Investigating Hosts

Hunter

Threat perform adhoc scan Scan Hosts

Hunter

Threat review host details Analyze Host Details

Hunter

Threat search on snapshot Search Files on Host

Hunter

Threat analyze processes Investigating a Process
Hunter

Threat review reported anomalies Analyze Anomalies

Hunter

Threat analyze risky users Analyzing Risky Users
Hunter

Threat analyze events Analyzing Events

Hunter

Threat download files for deeper analysis Analyzing Downloaded Files
Hunter

Threat perform external lookups Launch an External Lookup for
Hunter a File

Threat change file status or remediate Changing File Status or
Hunter Remediate

Threat isolate host from network* Isolating Hosts from Network
Hunter

Threat download MFT, download files, system dump, or Performing Host Forensics
Hunter process dump*

*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

¢ Investigating Hosts
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e Performing Host Forensics

e Isolating Hosts from Network

Quick Look

Below is an example of the Downloads tab:

AGENT ATUS AGENT LAST SEEN AG
Idle afew seconds ago 11

DETAILS R0C s | AUTORUNS  FILES DRIVERS  LIBRARIES ANOMALIES DOWNLOADS  SYSTEM INFO  HISTORY

Y Filters x = Downlosds | SavealocalCopy | | DeleteFile 3

NAME TvPE size DOWNLOADED TIME SHA256 FILEPATH

dwmee &5K8 Wdayzazo HBAIZITASHAab22480e .

1097K8 L 20533168700628c2555040e ... —

14298 20daysa0 14a5R0526d09:096914 eee .

219M8 20dayzao NA

Equals

Equals

@) cusToMDATE
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Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

Isolation host from the network. For more information, see Isolating Hosts from Network.

Download MFT to the server. For more information, see Performing Host Forensics.

Download files to the server. For more information, see Download Files Using Full Path or
Wildcard.

Download System Dump to the server. For more information, see System and Process
Memory Dump.

Filter Files. You can filter downloaded files by selecting the options in the Filters panel and
create filters. For more information, see Performing Host Forensics,

Actions in the toolbar:
Save a Local Copy - Lets you retrieve the downloaded MFT and save it to your local file
system for further analysis.

Delete File - Deletes the downloaded MFT from the server.

For more information, see Performing Host Forensics.

View MFT Details. Click the filename to view the MFT details. For more information, see
MFT Viewer,

The table displays the following information:

File Name Name of the file that is downloaded. For example, VGAuthService.exe,

Type Type of file downloaded - MFT, file, memory dump.
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Downloaded Status of the download:

- Download successful
. - Processing the downloaded file

. - Errors including download failed

- Errors downloading one or more files in the group.
Size Size of the downloaded file.

Downloaded Time Time when the MFT was downloaded.

SHA256 SHA256 of the file.

Note: This is applicable only for files.

MFT Viewer

You can analyze the downloaded MFT using the MFT Viewer. For more information, see Analyze
Downloaded MFT.

Below is an example of the MFT Viewer:
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< Downloads

PROCESE

Y Filters

| AUTORUNS

MFT-C-WINDOWS10-2019-11-14T06-47-52-T77Z

ProgramData
Program Files (xB6)
$RecydeBin

FILES

Hosts

afew seconds ago

LIBRARIES

_‘
S
=
-

NAME

NWE-Trace-Oclc bt

NWE-Trace-Qaccrar

NWE-Trace-Oacctxt

NWE-Trace-0f&0.rar

NWE-Trace-0f80.txt

NWE-Trace-0alc bt

11400

ANOMALIES

DOWNLOADS

SYETEM INFO

CREATION TIME ($FN)

11/12/2019 07:02:03 pm

11/12/2019 11:54:16 am

11/12/2019 12:48:33 am

11/12/2019 12:08:39 am

11/11/201% 09:25:01 pm

11/11/201907:32-11pm

] Perflogs NWE-Trace-Oc44 - Copy.bt 49.8MB
Program Files

7 $Extend

11/11/2019 06:56:29 pm

NWE-Trace-1fc0.tet 85KB 11/11/2015 05:44:35pm

2l L NWE-Trace-Ocd.txt 0 bytes 11/1172019 05:43:31 pm

Documents and Settings

NWE-Trace-0c30.txt 1019KE 11/1172019 05:42:05 pm

System Volume Information

DataCollector01Lcsv 642.9KB 11/11/2019 05:03:16 pm

DELETED FILES

NWE-Trace-264¢ - Copy.bt 210MB 11/11/201% 05:02-52 pm

ALL FILES

o000 0 0 D 000D O 0 DB

NWE-Trace-264¢ txt O bytes 11/06/2019 09-38:24 pm

Filter Files. You can filter files by selecting the options in the Filters panel and create filters.
For more information, see Filter MFT.

Folder Details. Lets you view the content of the MFT.
Download File to Server. Downloads files to the server.

The table displays the following information:

Column Description

Name Name of the file. For example, dtf.exe,
Size Size of the file.

Creation Time ($FN) File Name ($FN) creation time.

Creation Time ($SI) Standard Information ($SI) creation time.
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Modification time ($FN) $FN modified time.

Modification time ($SI)

Access time ($FN)
Access time ($SI)
Update time ($FN)
Update time ($ST)
Full Path
Allocated Size

Archive

Compressed

Encrypted

Hidden
Directory

Extension

$SI modified time.

$FN access time.

$SI access time.

$FN updated time.

$ST updated time.

Path of the file.

File size on the disk.
Indicates if a file is archived.
Indicates if a file is compressed.
Indicates if a file is encrypted.
Indicates if a file is hidden.

Indicates if it is a directory.

Type of the file. For example, exe, pdf, txt.
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Hosts View - System Information Tab

Note: The information in this topic applies to RSA NetWitness Platform Version 11.1 and later.

The System Information tab lists the agent system information. To access this tab, select a host from the
Hosts view and click the System Information tab.

Workflow

Review Hosts with
Highest Risk Score

Analyze Hosts
- Review Risk Contributors
- Perform Adhoc Sean
- Review Host Details, such as
Autorun, System Information,
Libraries, Processes, Drivers, Files

- Search on Snapshot

- Analyze Processes

- Review Reported Anomalies
(for Windows)

- Analyze Risky Users (Users View)

What do you want to do?

Download Files for
Deeper Analysis

Perform Host
Forensics

Perform External
Lookups

[Optional) Isolate
Host from Network

Analyze Events
(Navigate or Events g
View)

Change File Status Remediate

I

Threat Hunter

Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter
Threat Hunter

Threat Hunter

review hosts with highest risk score

analyze hosts*

perform adhoc scan*
review host details

search on snapshot*
analyze processes

review reported anomalies
analyze risky users
analyze events

download files for deeper analysis

Analyze Hosts Using the
Risk Score

Investigating Hosts

Scan Hosts

Analyze Host Details

Search Files on Host

Investigating a Process

Analyze Anomalies

Analyzing Risky Users

Analyzing Events

Analyzing Downloaded
Files

147
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arror i ooumron

Threat Hunter perform external lookups Launch an External Lookup
for a File

Threat Hunter change file status or remediate Changing File Status or
Remediate

Threat Hunter isolate host from network™ Isolating Hosts from
Network

Threat Hunter download MFT, system dump, or Performing Host Forensics

process dump*
*You can perform this task in the current view.

Related Topics

¢ Focusing on Endpoint Analysis

e Investigating Hosts

Quick Look

Below is an example of the System Information tab:

RSA
E

100 : ACENT SCAN STAT Ace ! ERSION NAPSHOT TIME  06/24/2020 21:30:33
windows a ® -

DETAILS ~ PROCESSES ~ AUTORUNS  FILES  DRIVERS  LIBRARIES A YSTEM INFO  HISTORY

Host File Entries

{1

127001

=
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3

.-

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

e Start a scan for the selected hosts. For more information, see Scan Hosts.

» Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

e Isolation host from the network. For more information, see Isolating Hosts from Network.

e Download MFT to the server. For more information, see Performing Host Forensics.

* Download System Dump to the server. For more information, see System and Process
Memory Dump.

Snapshot Time - Lists scanned time stamps. To view the scan history, you can select the
snapshot time from the drop-down menu.

Search on Snapshots. Lets you search on all snapshots (file name, file path, and SHA-256
checksum). For more information, see Search Files on Host,

System Information Panel - See System Information Panel.

System Information Panel

The System Information panel displays the following tabs:

Host File All network redirections written in the host file. For example, [P Address -

Entries 10.10.10.3 and DNS Name -
localhost, localhost.localdomain, localhost4, localhost4.localdoma
in4

Network Network name of the shared resource (for Windows only). For example, Name -

Shares Admin$, Description - Remote Admin, Path - C:\, Permissions - None, Type -
disk, special, Max Users - 4294967295, Current Users - 0.

Security Installed security products (for Windows only). For example, Display Name -

Products Windows Defende r, Instance - D68DDC3A-831F-4FAE-9E44-DA132C1ACF4 6,
Features - Enabled, Type - antiVirus,
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Windows List of patches applied by Windows update (for Windows only). For example,

Patches KB2959936,

Security Security configuration details on the host. For example, firewall disabled or enabled,

Configuration  smart screen filter disabled or enabled. This field is only applicable for Windows and
Mac.
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Hosts View - Agent History Tab
The Agent History tab lists the commands along with the respective status and additional details.

Quick Look
Below is an example of the Agent History tab:

Hosts

RSA i

.

cspor
@ WIN81x64-1 & : AGENTSCANSTATUS  AGENT LAST SEEN AGENT VERSION

Idle afew seconds ago 11500

DFTAIIS  PROCFSSFS ~ AUTORUNS  FIIFS  DRIVIRS  [IBRARIFS  ANOMAIIFS ADS  SYSTEM INFO  AGFNT HISTORY

Y Filters « | Agent History

HOST NAME COMMAND TIME COMMAND TYPE USER NAME

COMMAND TIME @) custompaTE
04/24/202007:03:34 am Scan admin

04/22/202009:29:38 am Reset File LogBookmark admin
COMMAND TYPE
04/22/202008:12:41 am Download File admin
04/22/20200 Reset File LogBookmark
04/21/20200¢ Download File system
04/21/202009:33:03 Download File system
REQUEST TYPE 04/21/20200 Download File system
04/21/20200 Download File system
04/21/2020 06:26:02 pm Download File system
COMMAND PARAMETER
Caitefrs 04/21/202006:26:02 pm Download File system

04/21/2020 06:26:02 pm Download File system

[ mea ] P —

Agent and Scan Details. You can view the following agent and scan details of the selected
host:

Host name - Name of the host. For example, WIN-ABC.
Risk score - Risk score of the host.

Operating System - Operating system on which the agent is running (Linux, Windows, or
Mac).

Agent Scan Status - Current status of the scan - Idle, Scanning, Starting Scan, or Stopping
Scan. For more information, see Scan Hosts.

Agent Last Seen - Time when the agent last communicated with the Endpoint server.
Agent Version - Version of the agent. For example, 11.3.0.0.
More - Provides options to:

o Start a scan for the selected hosts. For more information, see Scan Hosts.

e Extracts host attributes and endpoint data to a JSON file of the selected snapshot. For more
information, see Export Host Attributes.

¢ Isolation host from the network. For more information, see Isolating Hosts from Network.

¢ Download MFT to the server. For more information, see Performing Host Forensics.

e Download System Dump to the server. For more information, see System and Process
Memory Dump.
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Pl Search files on host, Lets you search the files on the host (file name, file path, and SHA-256
checksum).

R Details Panel- Displays information, such as:
e Command Time - Command issued time.

¢ Command Type - Type of the command (Identity, scan, stop scan, download file, MFT,
process dump, system dump, start isolation, update isolation exclusion list, stop isolation,
reset file logbookmark, and download multiple files, agent upgrade, and uninstall agent)
issued.

User Name - User who issued the command. For example, Analyst, System.

Status - Status (success, pending, expired, failed, or cancelled) of the command issued.

Note: If the command's status is expired, it means that the agent is unable to process the
command even after five retries.

e Command Parameter - Parameters associated with the command. For example, Command
parameter for command type Download File is path = C:\Windows\System32\ |
filename = cmd.exe | hash =
6£88fb88ffb0£f1d5465c2826e504£523598b1b8378377c8378ffebcl71badl8b

Note: Command types such as identity, scan, stop scan, stop isolation, system dump do not
contain any associated command parameters.

e Processed Time - Time at which the command is completed, pending, expired, failed, or
cancelled.

* Last Retrieval time - Last time when the command is issued to the agent.

e Total Retrieval - The number of times the command is issued to the agent.

Note: After you upgrade to NetWitness Platform version 11.5, the commands executed in the
previous versions are displayed automatically. The fields such as last retrieval time, total
retrieval, and user do not contain any values. For system generated commands, the user field
value shows as system.

Bl Filter Files. You can filter commands by selecting the options in the Filters panel. For more
information, see Filter Host Details.

Rl Settings Menu. You can set History view preferences by selecting columns from the Settings
menu.
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